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1   Introduction

1 Introduction
The QlikView tutorial is a self-study course for beginners. It contains explanations and lessons that take you step
by step through various features.

1.1 What is QlikView?
QlikView is a software that enables all kinds of users from beginners to experts to retrieve and assimilate data
easily from any source: databases like SQL Server or Oracle as well as Excel, XML or text files. Enterprise
applications such as SAP may also be used as data source for a QlikView analysis. Once loaded into the
program, the data is presented in an intuitive and easy-to-use interface. To make selections in QlikView, you do
not need any previous knowledge of databases or search routines: you simply click the item of which you want
to know more, and the program immediately filters the data and presents all associated items. Extensive search
options - direct and indirect - allow you to find any information and deliver instant answers to your questions.

QlikView offers a wide variety of graphs, charts and tables in different formats to present your data the way you
want. Different views, zoom, grouping or animation create a deeper understanding and provide an even better
overview. Creating the interface is very easy and does not require help from the IT department. Any graphic or
table can be printed or exported to other programs for further processing. QlikView standalone can be used for
free, as a Personal Edition. With QlikViewPersonal Edition you can make full use of the QlikView functionality, but
it is not possible to open documents created by other users. To do this, you need a QlikView license.

The QlikView product group also includes QlikView Server and QlikView Publisher that can be used for
centralized management of QlikView applications, for automated updates and for distribution of documents to
several users. Documents published on a QlikView Server can be accessed by different clients including Internet
Explorer Plugin, AJAX Zero Footprint and several mobile clients such as iPhone, iPad, Android and RIM devices.

1.2 About the tutorial
You do not need any prior QlikView experience or database knowledge to do the tutorial. Working through the
entire tutorial will take about 8 hours, but not all parts are equally relevant to every user. The tutorial consists of
three parts, briefly described below.

Working with QlikView
The first part, Working with QlikView, starts with a thorough description of how to make selections and searches
in an existing QlikView document. If you do not have the intention to build or modify QlikView documents, the
very first section of the tutorial may already provide sufficient information for the daily work. Working with
QlikView also introduces you to the components of the user interface of a QlikView document and demonstrates
how to use and create these components. This part is relevant if you are in charge of designing, building or
modifying the user interface of QlikView documents.

Working with QlikView (page 11)
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Creating a document
The second part, Creating a document, presents how to load data into QlikView. You will learn how to load data
from different sources, how QlikView builds associations between different sets of data and how to link external
information to the data. This part is crucial to when developing QlikView documents from scratch or modifying
the data structures in existing documents.

Creating a document (page 91)

Advanced features
Finally, Advanced features can be seen as a continuation of both of the previous parts. Here you will learn how to
build more complicated documents, as well as how to use more advanced features in the script, including access
restriction and number formats. Whereas the lessons in the first two parts build on each other, the lessons in the
third part are independent from each other and you can directly pick the topics that interest you.

Advanced features (page 117)

Going forward
Apart from this tutorial, there are many other resources for new and advanced QlikView users.

What's next? (page 146)

1.3 Preparations
To go through the lessons in this tutorial, you need to install QlikView on your computer. You also need a
number of sample files.

Installation
If you have not yet installed QlikView standalone on your computer, you should do so. The software can be
downloaded for free from www.qlik.com. To access the download page, you must register, or log in to your
QlikView account if you are already registered. If you have purchased a QlikView license, you can enter the
license number when starting the program for the first time. You can use QlikView Personal Edition without a
license.

Sample files
The Sample files are located in a folder called Tutorial that can also be downloaded from Access Now under
the QlikView Tutorial heading. If you have already installed QlikView, you can access the download area directly
from the start page.

Download the tutorial file package to your computer. The package includes QlikView documents as well as data
sources. Of course you can install it to any other folder of your choice. Just be sure to remember where to find
the files.
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1   Introduction

1.4 Conventions
Before you start using QlikView, it is important to understand the terms and notational conventions used in the
tutorial. In this section some of the terms will be explained.

Regional settings
Note that your computer’s regional settings might affect your work in QlikView. For example, the default date
and number formats differ between Swedish and English, which might affect calculations if you run English
QlikView on a computer with Swedish regional settings. To get the best possible results, run this tutorial on a
computer with the same language settings as the QlikView document.

1.5 Getting to know QlikView
This section gives a brief introduction about how to start working with QlikView, how to save your work and
where to find help.

The start page
On the start page, you find different shortcuts, such as a direct link to download this tutorial, links to selected
demo examples, a link to the QlikView demo example folder on your local computer and links to selected
resources at www.qlik.com.

You also find a list of recently opened documents. Click a document or in this list to quickly open it.

If you do not want the start page to appear when you start QlikView, deselect Show start page when
launching QlikView at the bottom of the start page. The start page can be reopened at any time by choosing
Show Start Page from the Help menu.

Starting QlikView
You find QlikView on the Start menu, under All Programs.

It is also possible to start QlikView by double-clicking a QlikView file.

In this case QlikView starts with the current document opened.

QlikView Tutorial - QlikView, April 2019 9
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Opening a document

To open an existing QlikView file, click Open on the File menu, or click on the toolbar. You can always

open the most recently used QlikView documents from the start page or the File menu.

Several files can be open simultaneously. Each document opens in its own window. In this case, you can
alternate between the documents from the Window menu, or by using the keyboard combination Ctrl+Tab.

Saving a document

To save a document, click Save on the File menu or click on the toolbar.

Closing a document
When you close a QlikView document, the selections made are preserved until you open the document again.

QlikView help
The complete online help for QlikView is available at help.qlik.com. You can searches for topics that contain
information that you are looking for or browse for information within different areas.

You can get help for a specific dialog or function by pressing the F1 key or clicking on the toolbar while
running QlikView.

Using documents on a QlikView Server
All variants of QlikView can be used to access documents on a QlikView Server. This is done by selecting Open in
Server in the File menu or the start page. Since we cannot assume that you have access to a QlikView Server,
this tutorial deals only with the use of local documents.

QlikView Tutorial - QlikView, April 2019 10
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2 Working with QlikView
This part of the tutorial will show you how to work with an existing QlikView document. Once familiar with the
basic terminology, you will learn how to make selections in QlikView. Subsequently, the components of the
QlikView document will be described one by one. You will learn how to modify and work with the different sheet
objects to get the results you are looking for.

2.1 Creating queries in QlikView
In this lesson you will get an overview of the basic components of a QlikView document and learn how to make
queries in QlikView.

Opening the document for the first time
Do the following:

1. Start QlikView by double-clicking on your desktop or from the Start menu.

2. On the File menu, choose Open.

3. Select the file Tutorial.qvw under ..\Tutorials source\Working with QlikView, or where your program files
are normally installed, then click Open.

You have now opened this QlikView document.

Getting familiar with QlikView
This is an example of what a document opened in QlikView may look like.
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2   Working with QlikView

A At the top of the screen you find the menu bar, and just below this, toolbars.

B Different sheets are shown as different tabs.

C A sheet can contain many different sheet objects, such as list boxes, bar charts and text objects.

D The most basic sheet object is the list box. Each list box represents a column (field) of the loaded
database table, and contains a number of (field) values.

E Buttons are used for performing certain commands.

F Sheet objects that you are not focusing on at the moment can be temporarily minimized.

G Search object

H Multi box

I Table box

J Bar chart

K Input box

L Text object

M Statistics box

N Current selections box

O Status bar

QlikView Tutorial - QlikView, April 2019 12
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Selections
In QlikView, the main way of making queries is through the selection of field values. When you make a selection,
the program instantaneously shows all the field values in the document that are related to the selected field
value. To make a query, or a search, in the database, you just click something you want to know more about.

Do the following:

1. Open the Geography sheet.

2. In the list box Country, select the value Albania.
The color of the cell turns green. In QlikView terms, the value is selected. The result of the search is
displayed instantaneously in all the other sheet objects. You immediately see which of the values in the
other list boxes are compatible with the selection and which are not.

The cells of associated field values are white. Selected and associated values are referred to as possible
values in this tutorial. A cell whose contents are not associated (whose value does not occur in
combination with that of the selected item) is called excluded. The cells of excluded values are gray. To

QlikView Tutorial - QlikView, April 2019 13
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facilitate the overview of the query result, the contents of the list boxes have been sorted, not only
alphabetically, but also by their state: optional values are put at the beginning of the list, excluded values
at the end.

3. To make another selection, simply click the selected cell again, or click another cell in the same list box.
The new selection will replace your previous selection.

4. To select more than one item in the same list box, hold the Ctrl key down while selecting additional
values. If the items you are selecting are adjacent to your first selection, you can instead hold the mouse
button down while dragging the cursor.

Combining selections
An optional value in another list box can be selected in combination with a previously selected value. When you
select an optional value from a list box and then select another optional value from another list box, QlikView
will show the combinations belonging to both selections as options. (This is equivalent to a “logical and”
condition.)

Do the following:

1. Clear your selections by clicking on the toolbar.

2. Click the Sales sheet.

3. Suppose you want to know which Salesperson has sold products to Captain Cook’s Surfing School in
Monaco. Go to the list box Customer and search for the value Captain Cook’s Surfing School.

4. Select the value by clicking it.

Seven values in the list box Country are white. This means that they are compatible with the selection.
Select Monaco.

You now see that Joe Cheng is the Salesperson you are looking for. The value Joe Cheng is the only one
compatible with both Captain Cook’s Surfing School and Monaco. By making consecutive selections this way, it
is possible get closer, step by step, to the answer you are looking for.

Keeping track of your selections
When you make many selections at the same time it can sometimes be hard to keep track of them. To help you
with this QlikView has two tools, the Current Selections box and the Current Selections window. This
Current Selections box lists all fields in which selections have been made and the values selected. If too many
values are selected, only the number of selected values is shown.

Using the Current Selections box
On the Geography sheet you will find a Current Selections box.

Do the following:
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l Make some additional selections in the list boxes and watch how they are reflected in the current
selections box.

Using the Current Selections window
Not all QlikView documents have current selections boxes on all sheets. If you want to keep track of your
selections anyway, you can use the Current Selections window.

1. Click on the toolbar.
A new window will now appear on top of the QlikView window. This window resembles the current
selections box quite a bit, but can be moved around as you please and will stay in place even if you go to
a different sheet or start working with another document.

2. Make some selections and watch how they are reflected in the Current Selections window.

3. Close the Current Selections window by clicking on the toolbar.

Moving selections
The current selections in an active list box can be moved using keyboard keys.

Do the following:

1. Clear your selections by clicking on the toolbar.

2. In the Country list box, select the value Afghanistan.
The values related to Afghanistan are now shown in the other list boxes.

3. Use the down arrow key of your keyboard to move the current selection one step downwards in the list
box.
Note that the other sheet objects are updated to show the result of the new selection.

4. To move the selection upwards, use the up arrow key.

Stepping back or forward in the list of selections
QlikView remembers the last 100 selections. By clicking the Back button on the toolbar, you go back to your
previous selection.

Do the following:

1. Click on the toolbar. Note that your previous selection is displayed.

2. Click again to go back another step.

3. Click on the toolbar, to move forward in the list of selections.
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This way, you can go back and forth in the list of selections as you wish. Note that the Back and Forward
buttons only apply to selections: other changes, like the removal of an object or the modification of a setting, are
not affected.

Locking and unlocking selections
By default, the logic of QlikView replaces a previous selection with the new selection if the previous selection is in
conflict with the new selection. To prevent this, selections may be locked. Locked cells are blue. A selection in
conflict with a locked selection will not be performed.

Locking and unlocking all selections
Do the following:

1. Select an excluded (gray) value.
Note that your old selection disappears.

2. Click on the toolbar. This will lock all selections, preventing them from being cleared by mistake.

3. Try to select an excluded value in another list box and note that it is not possible.

4. To unlock all selections, click on the toolbar.

Locking and unlocking individual fields
It is also possible to lock fields individually.

Do the following:

1. Select Albania in the list box Country.

2. Right-click on the list box Country, then choose Lock from the shortcut menu.
This will lock the selected field values of this specific field. Because the field Albania also exist in the multi
box called Multi Box, it is also locked there.

7. To unlock the selection in one field, choose Unlock from the shortcut menu of the list box containing it,
or from the Selections menu.

If there are no selected items in the list box, the Lock command in the shortcut menu is inactive (dimmed).

Searching values
QlikView includes different ways of searching for values in your data.

Normal text search
To find values in list boxes, especially in list boxes with many values, you can use the text search. Suppose you
are looking for the value Greece.

Do the following:

1. Clear your selections.

2. Click on the title bar of the list box Country (on the Sales sheet) to make it active.
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Active sheet objects have a green title bar in this document.

3. Type the letters gr.
The search string appears in a separate window. Now the list box shows only countries containing a word
starting with “gr”.

Instead of just starting to type you may also choose Search from the Edit menu or click on the toolbar. List
boxes can also be configured to hold a little search icon in the captions. These icons can be clicked directly to
open the search window. Pressing the Enter key will select all values matching your search string. You can also
click on the country you wish to select from the search results.

Numeric search
Similarly, if the search is made in a field containing numeric data, you can start your search string with greater
than “>” or less than “<” and then type a number. Suppose you want to select all countries with a population
above 1 billion.

Do the following:

1. Clear your selections.

2. Click on the title bar of the list box Population(mio).

3. Type >1000. The string appears in a separate window.
Only numbers above 1000 are now available in the list box.

4. Press Enter to select them.

The sheet objects are updated to reflect the result of the selection.

Using a search object
With the search object you can search simultaneously in multiple fields or all fields in the document.

Do the following:

1. Clear your selections.

2. On the Geography sheet, click the search bar located above the table box.

QlikView Tutorial - QlikView, April 2019 17



2   Working with QlikView

3. Type par.

As you can see, the search object offers you several hits for this search string, grouped by the fields containing
these values. To select values you can click on a value or on a field name to select all hits for this field. You can
even select several hits by holding the Ctrl key while clicking, provided that the selected values are logically
compatible with each other. You can use this kind of general search to find associated values in a list box.

To do so, click the chevron in the search window when searching in a list box. Apart from the search options
explained here, you can perform a fuzzy search to find values similar to your search string or an advanced
search to use search expressions. For more information, see the QlikView online help.

Selection bookmarks
It is possible to save a set of selections for later use.

Do the following:

1. Select one or several values, then choose Add Bookmark from the Bookmarks menu.
The default name for the created bookmark is that of the current date (displayed in the Add Bookmark
dialog, see the picture below).
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2. Change the name of the bookmark in the dialog if you wish, and then click OK.

3. Open the Bookmarks menu and note that the bookmark you just created is included in the list of created
bookmarks.

4. Clear the current selections.

5. To show the saved set of selections again, simply select the bookmark in the list.

A maximum of ten bookmarks can be displayed in the list. To see additional bookmarks, to get more details on a
specific bookmark or to delete a bookmark, choose More from the Bookmarks menu.

Bookmarks can also be created and selected using a bookmark object in the layout.

Creating a bookmark object (page 85)

Now that you have learned how to make selections in QlikView, it is time to describe the components of the
document more thoroughly. The most basic component is the sheet, which will be introduced in the next lesson.

Saving your work
If you do not want to turn to the next lesson right away, you can close the document. You should also save the
document, since the following lessons are based on the work you have done so far.
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1. Choose Save As from the File menu to save a copy of the document.

2. Type MyTutorial.qvw or something similar in the File name box, then click Save.

You can now close the file:

3. Choose Close from the File menu.

If you will not be working with QlikView for a while, you can also exit the program:

4. Choose Exit from the File menu.

Checking your work
Open the file TutorialFinal from the folder Working with QlikView and compare it with the one you just saved.

2.2 Handling sheets and sheet objects
This lesson introduces the sheet, which is the most basic component of a QlikView document. You will learn
about the logical connection between sheets. Another objective is to create a sheet, add sheet objects to it and
size as well as position them. To facilitate these tasks you will display and use the layout toolbar. Basic object
formatting is also included at the end of this lesson.
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Opening the document
If you closed the document and exited QlikView after the previous lesson, you need to open it again.

1. Start QlikView by double-clicking the QlikView icon on your desktop.

2. Open the MyTutorial.qvw file. If you used the file recently you can open it directly from the Recently
Opened Documents tab on the Start page.
Opening a document (page 10)

Sheets
The sheet can be considered the most basic component of QlikView because it holds all the different objects. A
document usually contains several sheets, which is useful when you want to achieve a more structured layout.
Any sheet object can be put on any sheet. The sheets will, however, still be logically connected, which means that
a selection made on one sheet will affect all sheet objects on all other sheets.

Each sheet has a tab associated with it. the tab helps you find the sheet you are looking for because it contain
the sheet's name. By clicking on a tab, you activate the sheet attached to it. You can recognize an active tab
from the bold text.

Logical connections between sheets
There are two sheets in your document: Geography and Sales. Geography is the active sheet. The sheets are
logically connected, that is a selection made on one sheet will affect all sheet objects on all other sheets.

Do the following:

1. Click the tab Sales.
The tab name changes from normal to bold, and the sheet associated with it is shown.

2. Select the value Albania in the list box Country.
The cell of the selected value turns green and you immediately see all the values of all other fields that
are compatible with the selection (white). You see that the fictive company has one customer in Albania,
Moe’s Laundromat, and that John Lemon is responsible for the sales.

3. Go to the sheet Geography by clicking on its tab.

The sheet Geography also contains a Country list box. Note that the value Albania is selected (green) in this list
box too, although you made your selection on the sheet Sales. The green dot on the tab Sales. This is a selection
indicator, helping the user to keep track of selections made on other sheets. If referring to a locked selection, the
selection indicator is blue.
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2   Working with QlikView

4. Click the tab Sales.

5. Select the item Cezar Sandu (currently excluded) in the list box Salesperson.
You immediately see that Cezar Sandu has been active in France, Germany, and Mongolia. The item
Albania, which is not compatible with the selected item Cezar Sandu, has been excluded.

6. Click the tab Geography.
The data displayed in the sheet objects has been updated to show the result of the new selection: France,
Germany, and Mongolia, as well as the items related to these countries, are shown as optional (white).

7. Clear your selections by clicking in the toolbar.

Adding a sheet
Do the following:

1. Choose Add Sheet from the Layout menu.
A new sheet appears.

2. Right-click the empty sheet and choose Properties from the shortcut menu.
The Sheet Properties dialog appears.
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3. On the General tab, change the title from Sheet2 to Customers.
By default, a new sheet inherits the default background that is set in the document properties. If you want
the sheet to have a different background, you can set a special background color or image for the sheet
in the Background group on the General tab. We will leave this setting unchanged.

4. Still in the Sheet Properties dialog, click the Fields tab.

5. Select Customer, then click Add >.
The field has now been moved to the column of displayed fields, which means that it will appear as a list
box on your sheet.
You can also double-click fields in the left column to move them to the right .

6. Double-click the field name Customer ID.

7. Click OK to close the dialog.

You have now created a new sheet containing two list boxes. The list boxes are not placed where you want them,
you will fix this soon.

Instead of creating a new sheet, it is also possible to right-click an existing sheet and selecting Copy Sheet. When
copying a sheet, all sheet objects on that sheet are copied at the same time.

Adding new sheet objects
If you right-click somewhere on the Customers sheet, and then select New Sheet Object, you see this list of all
the sheet objects that can be used in QlikView.
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All the sheet objects except buttons, text objects and line/arrow objects can be used for making selections in the
data. All sheet objects may be used for viewing the result of selections.

The Customers sheet created in the previous lesson contains two list boxes, Customer and Customer ID.
Suppose you want to add a third sheet object: a list box containing countries.

Do the following:

1. Make sure that the Customers sheet is active, then right-click somewhere on the sheet.

2. Select New Sheet Object, then List Box. The New List Box dialog opens.

3. On the General tab, select Country from the Field drop-down list.

4. Click OK.

The Country field now appears as a list box on your sheet Customers.

Moving a sheet object
To move a sheet object you, select it with the mouse button, then keep the mouse button depressed while
dragging it. To move a sheet object step by step, press Ctrl+arrow. For bigger steps, use Ctrl+Shift+arrow.

Do the following:

l On the sheet Customers, align all sheet objects vertically on the left hand side of the sheet.

Undo layout change
QlikView maintains a list of the latest layout changes. You can use the Undo layout change command to take
you backwards one step in the list whenever something goes wrong or the result of the last change was not
satisfactory. Undo layout change refers to moving, sizing and removing sheet objects as well as changes to
document, sheet and sheet object properties.

Do the following:
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l Click on the toolbar to undo your latest layout change. The list box moves back to its previous
position.

You can also press Ctrl+Z to undo your changes.

Selecting and moving several sheet objects simultaneously
To move several sheet objects at the same time, start by selecting them.

Do the following:

1. On the sheet Customers, place the cursor in the top left corner, then drag a rectangle enclosing all the list
boxes that you want to move.

Note that the title bars of the enclosed list boxes turn green after you let go of the mouse button. This
means that they are selected, that is active.

2. Place the cursor on the title bar of one of the list boxes, then drag.
All the selected list boxes are moved.

If the list boxes are not perfectly aligned, do not worry - you will fix this in a moment.

QlikView Tutorial - QlikView, April 2019 25



2   Working with QlikView

It is also possible to select several sheet objects by Shift-clicking their title bars. To select all objects
on a sheet, press Ctrl+A.

Copying sheet objects
To copy a sheet object on the same sheet, press the Ctrl key while placing the cursor on the title bar of the object
that you want to copy. Drag the cursor to the place where you want to put the copy of the sheet object. You can
either copy sheet objects to another place on the same sheet, or to another sheet.

Do the following:

1. Click the tab Geography.

2. Press the Ctrl key while placing the cursor on the title bar of the list box Country.

3. Drag the list box to the tab Customers.

4. When the cursor turns into a white arrow on the tab Customers, release the mouse button, then the Ctrl

key.

5. Click the Customer sheet to make sure that a copy of the Country list box has appeared. Its position on
the sheet is now the same as on the sheet from which it was copied. Move it to the right of the other
Country list box.

Sizing a sheet object
You can size list boxes (and other sheet objects) by dragging the window frame of the object.

Do the following:

1. On the sheet Customers, click the title bar of the list box Customer ID to make it the only active list box.

If other list boxes are active, they will be sized as well.

2. Move the cursor to one of the corners of the list box until the appearance of the cursor changes.
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3. Press the mouse button and drag the corner.

The Customer ID list box now overlaps the list box next to it. You will deal with this in the next section.

Aligning and distributing sheet objects on the sheet
There are several commands that help you tidy up the layout of your sheets by aligning and spacing your sheet
objects.

Do the following:

1. Select all list boxes on the Customers sheet.
You can tell from the green title bars which list boxes are selected (active).
As you are going to align the list boxes vertically, you may want to make them a little smaller. While
several list boxes are selected (active) at the same time, you can size them all at once by dragging one of
the window frames.

2. In the Layout menu, select Align/ Distribute and Adjust Top.
The list boxes are now evenly spaced horizontally, but you also want them to be aligned to the left.

3. Select all list boxes again if necessary, then choose Left Align.

4. While the list boxes are still active (green), move them down a little on the sheet.

Feel free to experiment with the layout. You can always use Undo Layout Change or press Ctrl+Z
(Windows standard) to undo your layout changes.

Displaying and using the design toolbar
If you use a QlikView document only for making selections, the standard and navigation toolbars are sufficient:
they contain the most common commands for working with a document. However, as soon as you modify the
layout, add objects etc., the design toolbar may be helpful. The design toolbar contains commands for adding
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sheet objects, moving sheets, and adjusting the layout.

Do the following:

l Select View > Toolbars > Design to show the design toolbar.

Minimizing and restoring a sheet object
List boxes and other sheet objects can be minimized if, for some reason, you do not want them on the screen
now but might need them again later.

Do the following:

1. On the Geography sheet, right-click the Capital list, and choose Properties.

2. On the Caption tab, select Allow Minimize, and click OK.

The minimize symbol appears in the top right corner of the list box.

3. Click the symbol or double-click the title bar of the list box.
The list box turns into an icon, which is placed where there is space on the sheet. The icon can be moved
freely.

4. Restore the list box by double-clicking the icon.

Auto minimizing
Auto minimizing is a useful function where only one of the charts on a certain sheet will have its full size at any
given time. The others are minimized to save space on the sheet. The charts Area and Population on the
Geography sheet have been preset to Auto Minimize.

Container object
The container object is a tool for showing several object types in a limited space. For more information, see the
QlikView online help.

Removing a sheet object
If you have followed all the steps above, there are two Country list boxes on your sheet Customers. Since you
only need one, the other can be removed.

Do the following:

1. On the sheet Customers, right-click on one of the Country list boxes, and click Remove.

2. Click OK.
The list box disappears from the screen.
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You can also remove a sheet object is by selecting it and pressing the Delete key.

Changing the border of a sheet object
Every sheet object has a border that can be given a number of different layouts. You can change the border
layout.

Do the following:

1. Right-click the list box, and choose Properties.

2. On the Layout tab, select a border style of your choice.

3. Click OK.
To keep a consistent layout, you should undo your change regarding the border.

4. Click Undo Layout.

If you want all the sheet objects in the document to have the same border, you should change the
setting on the Layout tab of the Document Properties dialog instead.

Setting properties (page 86)

Changing the font of a sheet object
You can change the font and its size, color and style.

Do the following:

l To change the font of a single object, open the Font tab in the Properties dialog of the particular object.

l To change the font of the entire document, open the Font tab of the Document Properties dialog.
Setting properties (page 86)

Copying layout formats between sheet objects
If you want to copy formats from an existing sheet object to other sheet objects, you can do this by using the
Format Painter. The statistics box Population (mio) on the Geography sheet does not have the same layout as
the other sheet objects. You can easily change that.

Do the following:

1. Select a sheet object that has the correct layout, for example the table box, so that its caption turns
green.

2. Click on the Design toolbar.

3. Click the statistics box Population (mio).
The layout (border and caption) of the statistics box changes.
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Using the format painter for several sheets
You can use the Format Painter tool for any sheet object. You can also use it for several sheet objects at once.
Just click the source object, then double-click on the Format Painter button and click on each of the target
objects. To end the “painting”, click the Format Painter button again or press Esc.

Linked objects
If you want several objects to have the same layout properties, you can use linked objects. These are objects that
share all properties with the exception of size, position and display state (minimized, normal or maximized).
When you change the properties of one object the change is immediately reflected in the other linked objects.
Linked objects can reside on the same sheet or on different sheets.

Do the following:

1. Right-click a sheet object and click Copy to Clipboard > Object.

2. Right-click somewhere on the sheet (or on a different sheet) and click Paste Sheet Object as Link.

3. Save your document.

Saving, closing and exiting
If you don’t want to turn to the next lesson right away, you can close the document. You should also save the
document, since the following lessons are based on the work you have done so far.

2.3 List boxes and statistics boxes
In the previous lesson you learned to add, copy, move, size and remove list boxes and other sheet objects. You
will now learn to modify a list box and its way of displaying data. The sort order and the number format are
examples of properties that you will change. At the end of the lesson, you will also learn how to create and use a
statistics box.

Opening the document
If you closed the document and exited QlikView after the previous lesson, you need to open it again.

1. Start QlikView by double-clicking the QlikView icon on your desktop.

2. Open the MyTutorial.qvw file. If you used the file recently you can open it directly from the Recently
Opened Documents tab on the Start page.
Opening a document (page 10)

The list box
The list box, which is the most basic object on the screen, contains a list of all the values of a specific field
(column) in the database.

QlikView Tutorial - QlikView, April 2019 30



2   Working with QlikView

All the values contained in the database field are shown in the list box. If there is not enough space to show all
values in the visible part of the list box, scroll bar are displayed on the right in the bottom. If a value occurs
several times in one and the same field, it will only be displayed once in the list box.

Showing frequency
Suppose you are interested in knowing how many customers you have in different cities.

Do the following:

1. Clear your selections.

2. On the Sales sheet, right-click the City list box, and click Properties.

3. On the General tab, check Show Frequency.

4. Click OK.
Any city in the list box is now followed by its number of occurrences in the data. As the field City is part of
the customer data, we can interpret this as the number of customers. In Alma-Ata we have two
customers, for example.

5. Undo the change that you made, using Undo Layout Change.

Changing the number format
Numeric data can be of different types and can be formatted in different ways.

Do the following:

1. Right-click the list box Sales, and choose Properties.

2. Click the Number tab.
The number format of the field Sales is disabled because all number formats are inherited from the
document’s default settings. Furthermore, the default settings in the document are affected by your
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computer’s regional settings.

3. To create a separate number format for the Sales list box, check Override Document Settings.

4. Select the option Money, then click OK.
The values in the list box Sales are now formatted differently (you may need to size it first): a comma has
appeared as thousands separator and the values are preceded by a $. Two decimals have been added.

5. Open the Properties dialog again.

6. Under Format Pattern, erase the two decimals (the zeros) and the decimal point that precedes them.
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If you cannot erase the zeros, or have different number formats by default, you need to change your
computer’s regional settings.

7. Click OK to close the dialog.
The decimals are no longer visible.

Changing the sort order
A number of different sort orders are available for each list box. Numeric fields are usually sorted by numeric
value, whereas fields containing text tend to be sorted in alphabetical order (Text). In addition, list boxes whose
values are not all visible (list boxes with scroll bars) are set to Sort by State, which means that the values are
sorted according to their logical state (selected, optional, excluded). This way, selected and optional values are
always visible in the document.

Do the following:
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1. On the Sales sheet, right-click the list box Sales, and choose Properties.

2. Click the Sort tab.
The list box Sales is sorted by State and Numeric value, Ascending. The order of the sort options in the
list corresponds to the priority sort order.

As long as no selection is made, the values in the list box Sales are sorted by numeric value. When a
selection is made, however, the state of the values determines the sort order.

3. Keep the option Numeric value selected, and click Descending from the drop-down box.

4. Click OK.
The highest number is now at the top. As soon as a selection is made, however, the selected (green) value
(s) or optional (white) values will be placed at the top.

5. Make a selection in the list box and study the result.

6. Clear your selections.

Changing the number and order of columns
To display the contents of a list box in several columns.

Do the following:

1. Clear your selections.

2. On the Sales sheet, right-click on the Day list box, then choose Properties.

3. On the Presentation tab, clear the Single Column check box and select Cell Borders. Click OK.

4. If necessary, drag the border of the Day list box until its contents are displayed in seven columns.
The values are ordered by column, that is vertically.
You may prefer to have the values of the Day list box ordered by row:

5. Right-click the Day list box, then choose Properties.

6. On the Presentation tab, clear the Order by Column check box, then click OK.
The field values, instead of being ordered by column (vertically), are now ordered by row (horizontally).
Your list box now looks like this:
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You can change the number of columns by changing the width of the list box. You change
the width by dragging the borders with the cursor.

1. Adjust the Month list box so that the months are grouped by quarters.

Aligning the values
Text is usually left-aligned, numbers right-aligned. This setting can be changed on the Presentation tab.

Do the following:

1. Right-click the list box Year, and choose Properties.

2. On the Presentation tab, in the Alignment group, click Left for Numbers.

3. Click OK.

The statistics box
The statistics box is a compact way of showing a numeric field in which the separate records are not used until
their sum or average has been calculated.

A number of different statistical functions can be used in a statistics box. It is also possible to make selections in
the statistics box by clicking on some of the functions, for example Min or Max.

Creating a statistics box
1. Clear your selections.

2. On the Sales sheet, right-click the list box Sales, and choose Create statistics box.
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A statistics box with the same name as the active list box appears on the screen. You might need to size it
to see all the numbers properly.

3. Point to the right border of the statistics box. When it looks like the picture you can start dragging.
The statistics box shows too many decimals at the moment.

4. To limit the number of decimals shown for each value, right-click the statistics box, and choose
Properties.

5. Click the Number tab. Under Functions, select Average and check the Override Default Settings.

6. Click Fixed to and set counter to 2 decimals.

7. Click OK.
You immediately see that the average sales of a fictive company is USD 3,249.98. In addition, the you
learn that the total sales is USD 2,317,233, and that 713 sales have been performed.

You can also create statistics boxes by choosing New Sheet Object > Statistics Box from the New
Sheet Objectmenu or by clicking Create Statistics Box on the toolbar.

Making selections in a statistics box
You can make selections in a statistics box by clicking on the non calculated functions, for example Min or Max.

Do the following:
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1. In the statistics box, click the function Max to find the customer who made the biggest purchase.
The selection is made in the list box to which the statistical value belongs.

2. Clear your selections.

Saving, closing and exiting
If you don’t want to turn to the next lesson right away, you can close the document. You should also save the
document, since the following lessons are based on the work you have done so far.

2.4 Bar charts and pie charts
Due to the variety of chart subtypes, and considering the great number of available settings, the tutorial
provides three lessons on charts. This lesson will start by giving you a general introduction to working with
charts. Subsequently, you will create a simple bar chart. Once familiar with the basics, you will modify the
properties of the chart and finally turn it into a pie chart.

Introduction
Charts and tables are sheet objects that can show numbers compactly. For example, you can show sums of
money distributed over different fields such as year, month, account number. Numbers that are calculated using
several records in the input tables (sums, averages, min, max) can only be shown in charts or statistics boxes.

Charts can be shown as:

l Bar charts

l Pie charts
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l Scatter charts

l Line charts
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l Combo charts (bar/line)

l Radar charts

l Grid charts

l Gauge charts
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l Funnel charts

l Mekko charts

l Straight tables
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l Pivot tables

l Block charts

Making selections in a chart
Until now, we have only studied selections in list boxes. It is however also possible to select data in charts.
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Do the following:

1. On the Geography sheet, place the cursor in the Area bar chart .
It shows the world’s ten largest countries.

2. With the cursor, drag and select a few countries.
The countries represented by the bars have been selected. The change is reflected in the Country list box
. It is also possible to make selections by clicking on the country names (labels) in the chart.

3. Select one or several countries.

4. Clear your selections.

Changing chart types using a fast type change
Some charts in QlikView are prepared to be displayed as more than one type. This is shown as a little icon, either
in the chart’s title bar or in the chart itself. The icon is a miniature representation of the next chart type that will
appear if you click it.

Do the following:

1. Click the Geography sheet.
In the bar chart Area you will find a fast type change button next to the minimize button.

2. Click the Fast type change button.
The chart turns into a line chart. This chart has been prepared to change between three types of charts:
bar, line and pie. If you click again the chart will turn into a pie chart.

3. Right-click the Fast type change button.

A drop-down menu will appear with the possible chart types.

4. Choose bar chart and you are back where you started.

All charts can be turned into any of the chart types available by going through the chart’s Properties dialog
that opens when you right-click a chart.

Creating a bar chart
The toolbars contain two options for creating charts.
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l The Quick Chart Wizard button on the Standard toolbar
The wizard helps you create some of the most common chart types in a few simple steps. The number of
options is limited in the Quick Chart Wizard, but once the chart is finished, you can add all kinds of
properties to it.

l The Create Chart button on the Design toolbar
This option opens the full chart wizard in which you can set a greater number of properties from the very
beginning.

If the toolbars are not visible, you display them by clicking View > Toolbars.

Creating a bar chart using the quick chart wizard
You will start by creating a simple chart showing the sum of sales per country.

1. Open the Sales sheet, and click Quick Chart Wizard on the Standard toolbar.
The Quick Chart Wizard opens.

Step 1 of the wizard contains icons representing different chart types.

The icon representing the bar chart is selected by default.

2. Click Next >.
The Define dimension(s) page opens.

To define the meaning of each bar in the bar chart, select a dimension. In this case each bar will
correspond to a Country.

3.1. For First Dimension, select Country and click Next >.

The Define Expression page opens.

To define what value the height of the bars in the bar chart corresponds to, you need to define an
expression. The answer, in this case, is the sum of sales for each country.

4. Sum is checked by default, and now you select Sales from the drop-down list and click Next >.

5. Keep the default settings for Style, Orientation and Mode on the Chart format page but check Show
Numbers to show numbers above each bar.

6. Click Finish.
The chart now appears on your sheet. Due to different default settings on different computers, its colors
may differ from the pictures in this tutorial.

7. To make additional adjustments to the chart, right-click it and select Properties.

8. On the General tab, type Sales 1 for Window Title.

9. Make sure that Show Title in Chart is checked, and type Sales per Country in the box.

10. On the Caption tab, click Auto Minimize.

11. Click OK.

12. On the Sales sheet, select Ann Lindquist from the Salesperson list box.
The chart immediately displays the countries to which Ann Lindquist has sold products, as well as the
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amounts of money involved.

Creating a bar chart using the full chart wizard
You will now create the same chart one more time - this time using the full chart wizard.

Do the following:

1. Open the Sales sheet, and click Create Chart on the Design toolbar.
The General page of the chart wizard appears. On this tab you can choose the type of chart you would
like to work with. The bar chart option is selected by default. Leave it that way.

2. Type Sales 2 for Window Title.

3. Make sure that Show Title in Chart is checked, and type Sales per Country in the box.

4. Click Next >.
The Dimensions page, where the dimensions to be shown on the x-axis is defined, opens.

5. Since you want each bar to represent a country, select Country from the list and click Add> to move it
to the list of displayed fields.

You can also double-click the field to add it.
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6. Click Next >.
The dialogs Expression and Edit Expression open, for you to set one or more expressions to be
displayed on the y-axis. You can type an expression directly into the text area in the Edit Expression
dialog, but it is also possible to use predefined functions for Aggregation and select fields in the Field
list.

7. To make the height of each bar to show the sum of sales for each country, select Sum in the
Aggregation drop-down list and Sales in the Field list.
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8. Click Paste.
The function and field that you selected appears as an expression in the edit box in the upper part of the
dialog.

9. Click OK.
The dialog closes. The expression you just defined appears in the Definition field (the left part) of the
Expressions dialog .You have now selected one dimension and one expression, and have performed the
basic steps of chart creation.

10. In the Label box, type Sales.
This changes the name of the expression.
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10. Click Next > until you reach the Caption page.

11. Check Auto Minimize.

12. Click Finish to close the wizard.

When you select Ann Lindquist in the Salesperson list box, and compare the two charts you just created, you will
notice that there are no numbers displayed above the bars in the second bar chart. The bars are also sorted
differently. This is due to different property settings.

Removing a chart
You only need one of the charts you created.

Do the following:

1. Right-click the first bar chart you created and choose Remove.

2. Confirm that you want to remove the chart.
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Changing a few properties
The tabs of the Properties dialog differ a little depending on the chart type that you have chosen. However, they
look the same no matter if you have used the quick chart wizard or the full chart wizard to create your chart.
You will now use a few of the settings found on the remaining tabs.

Changing the sort order
The bar chart you just created is currently sorted in alphabetical order.

You may prefer to put the main customer country furthest to the left.

Do the following:

1. Right-click the bar chart, and click Properties.

2. On the Sort tab, select the option Y-value to sort the countries according to their total sales.

3. Click OK.
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The bars are now sorted based on the expression sum of sales.

Limiting the number of bars
To improve the overview of the chart, you can limit the maximum number of bars to be displayed.

Do the following:

1. Clear the current selections and have a look at the bar chart you created before.
Notice that it is difficult to interpret the bar chart with the large amount of bars.

2. Right-click the bar chart, and choose Properties.

3. On the Dimension Limits tab, check Restrict which values are displayed using the first
expression.
The default setting is that the 10 largest values are displayed.

4. Click OK.
Now have a look at the bar chart again, and notice that the overview is improved as only 10 bars are
shown.

Displaying numbers on the bars
The next thing we want to do is to display numbers above the bars in our chart.

Do the following:

1. Right-click the chart, and choose Properties.

2. On the Expression tab, check Values on Data Points in the Display Options group.
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3. Click OK.
You have now added the y-value numbers (in this case sales figures) above the bars.

Changing the number format
Displaying the numbers above the bars is very useful, but when a large range of values is shown, there is not
enough room for all the numbers. You can solve the problem by changing the number format:

1. Right-click the bar chart, and choose Properties.

2. On the Number tab, select Sales.

3. Select Number in the Number Format Settings group.

4. In the box Symbol, type $.

5. Click OK.

6. Resize the chart to have all numbers displayed properly.

The numbers above the bars now have a thousand separator.

Cloning and detaching your chart
You can clone (copy) a chart in the same way as a list box (by Ctrl-dragging), but you can also right-click the
chart and choose Clone.

You can detach the cloned chart, this means that the chart will not be updated when selections are made. This
can be useful when you want to keep the overview while making selections.

Do the following:
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1. Right-click on the chart, click Detach on the shortcut menu.

2. Make a few selections.
See how the original chart is updated, but the detached chart stays the same.

3. Attach the chart again by choosing Attach from the shortcut menu.

4. Clear your selections.

Turning the bar chart into a pie chart
There are several different chart types to choose between, each one with properties that suit certain purposes.
You will now turn the second bar chart into a pie chart.

1. Right-click the chart Sales 2, and choose Properties.

2. On the General tab, click the pie chart icon in the Chart Type group.

3. Change the Window Title to Sales and the chart title to Most important countries.

4. On the Presentation tab, check Show numbers in Legend (which corresponds to Numbers on Data
points for bar charts).
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5. On the Style tab pick a style of your choice for the pie chart.

6. Click OK. The result is a pie chart where each slice represents the sales in a particular country.

Changing the color settings
Go to the previously created bar chart (Sales). Note that all the bars have the same color. This can be changed
on the Colors tab.

Do the following:

1. Right-click the chart, and choose Properties.

2. On the Colors tab, check Multicolored, and click OK.
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Compare the colors used in the bar chart with those of the pie chart. You see that the same colors are used for
the same countries. This default setting is very useful in that it enhances the consistency between different charts
and sheets. The colors of the color map can be customized: on the Colors tab, click on the color that you would
like to change and pick the color of your choice from the map that opens.

Showing the percentage
Since the pie chart illustrates proportions, you might be more interested in knowing the percentage than the
actual sum of sales.

Do the following:

1. Right-click the chart, and choose Properties.

2. On the Expressions tab, check Relative, and click OK.
The percentage numbers now appear in the legend.

To save space, you can minimize the pie chart.

Do the following:
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l Right-click the chart, and choose Minimize.
The chart turns into an icon and is placed where there is space on the screen. You can move the icon
freely.

Repeat 1-3 to minimize the bar chart that you created in the previous lesson.

In the next lesson, you will add another dimension to an existing bar chart and create pivot tables and straight
tables.

Saving, closing and exiting
If you don’t want to turn to the next lesson right away, you can close the document. You should also save the
document, since the following lessons are based on the work you have done so far.

2.5 Pivot tables and straight tables
In this lesson, you will continue creating and using charts. After adding a dimension to an existing bar chart, you
will turn it into a pivot table. Subsequently, you will create a straight table containing the same information to
compare these two ways of presenting data.

Adding a dimension to a bar chart
Until now you have worked with only one dimension and one expression. Charts can be very complex, though.
They can show several dimensions and/or expressions simultaneously or sequentially.

You will start by creating a chart with two dimensions and one expression. It will still show the sum of sales per
country, but grouped over different years.

Do the following:

1. On the Sales sheet you find the minimized chart Sales per Country.
It is very similar to the bar chart Sales 2 that you created in the previous lesson.

2. Right-click the bar chart Sales 2, and choose Properties.

3. On the Dimensions tab, move Year to the list of Used Dimensions.

4. On the Style tab, set Subtype to Stacked.

5. On the Dimension Limits tab, check Restrict which values are displayed using the first
expression and click Show only. From the drop-down list, select Largest and type the number 5 for the
dimension Country.

6. Click OK to finish the chart.
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Turning a bar chart into a multidimensional pivot table
Displaying data graphically is very illustrative, but you cannot show too much information at the same time
without losing clarity. To display calculated data for several dimensions, your choice of chart may be a pivot
table.

Do the following:

1. Right-click to open the Properties dialog of the bar chart you just added a dimension to (Sales per
Country).

2. On the General tab, change the Window Title to Pivot Table.

3. In the Chart Type group, choose the pivot table icon.

4. On the Dimensions tab, add Salesperson to used dimensions.

5. On the Sort tab select the dimension Country. In the Sort by group, clear the check box Y-value to sort
the values according to the text.

6. Click OK.

Expanding and collapsing dimensions
You have now created a pivot table with three dimensions, but you only see the dimension Country at the
moment. Pivot tables provide a useful feature: the possibility of expanding and collapsing dimensions by value
level. By collapsing the values you are currently not interested in, you considerably enhance the overview of your
data. You have probably noted the plus sign in the Country column. It indicates that the next level is hidden
(collapsed).

Do the following:

1. Right-click in the Country column, and choose Expand all.

2. Right-click in the Year column, then choose Expand all.
The table does not hold any more levels as there are no plus signs in the right-most column Sales. In the
expanded levels, the values have a minus sign displayed next to them. It indicates that the next level is
visible (expanded). Using the plus and minus signs you can expand and collapse single values in the table.
Use them to look exactly at the data you are interested in.
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3. Right-click in the Year column, and choose Collapse all.

4. Right-click in the Country column, then choose Collapse all.
Now, all the values of the dimensions Year and Salesperson are hidden again.

5. If you, for example, are only interested in the sales performed in Belgium, click the plus sign of the value
Belgium.

6. Click the plus sign of the values 2008 and 2009.

You are now showing only those values of the following columns that are related to the value Belgium.
Details on salesmen are only visible for 2008 and 2009.

Dragging dimensions
The pivot table is a very flexible sheet object that allows you to freely drag and drop the different dimensions and
expressions to any position on the vertical or horizontal axis. In our case, you may prefer to present the
dimension Year on the horizontal axis.

Do the following:

1. Position the mouse cursor on the field Year.

2. Press the mouse button and drag the field upwards, to the right, to the desired position (below the header
row).
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A blue arrow appears when the cursor is in the right place.

3. Release the mouse button.
The dimension Year, as well as the expression values, are now displayed on the horizontal axis.

The fields Country and Salesperson are shown as regular columns. The values in the field Year act as
headers for the remaining columns. The columns contain the values of the expression (Sum of Sales).

4. Drag the dimension Year back to form a vertical column and place it to the right of the dimension
Salesperson.

Adjusting the columns
The Country and Salesperson columns of the pivot table are not wide enough for certain values.

Do the following:

1. Place the cursor on the line separating the Country column from the Salesperson column.

2. When the cursor looks like the one shown in the figure, press the mouse button and drag.

3. Adjust the Salesperson column accordingly.

All the columns can be sized this way. To adjust the rightmost column, place the cursor within the border (to the
left of the scroll bar) and drag.

You can also adjust the columns using the command Fit Columns to Data in the shortcut menu that opens
when you right-click the table.
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Showing partial sums
At the moment, the table shows the sales for Belgium made by different sales persons during the years. Suppose
you wish to know the sum of sales made by all sales persons and for all years together.

Do the following:

1. Right-click the pivot table and choose Properties.

2. On the Presentation tab, under Dimensions and expressions, select Salesperson and Year.

3. Select the check box Show Partial Sums.

4. Click OK.
The pivot table now shows partial sums per sales person and on year level.

Creating a straight table
In opposition to the pivot table, the straight table cannot display sub-totals or serve as a cross table. On the other
hand, any of the columns of the straight table can be sorted and each of its rows contains one combination of
dimension(s) and expression(s).

Do the following:

1. Minimize the pivot table on the Sales sheet to increase the free space.

2. Right-click in an empty space on the sheet and click New Sheet Object, then choose Chart.

3. In the wizard that opens, click the Straight table icon.

4. For Window Title, type Straight table.

5. Click Next >.

6. On the Dimensions tab, add these fields in the following order: Year, Country and Salesperson to
move them to the Used Dimensions box. Click the Promote and Demote buttons to sort the dimensions
as shown in the picture.

7. Click Next >.
The Edit Expression dialog opens.

8. Compose the expression Sum (Sales) by selecting the corresponding items from the Aggregation and
Field lists.

9. Click Paste, and then OK.

10. For Label, type Sales.

11. Click Finish.
You now have a straight table containing the same information as the pivot table.

Compare the two tables. Notice that in the straight table, the total sum of sales is shown at the top, that each row
in the straight table represents a possible combination of data (in the pivot table, data is grouped by field
values), and that no partial sums are given.

Sorting the table
The straight table provides excellent possibilities for sorting columns.
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Currently, the column Year is placed furthest to the left, and the table is sorted according to the sort order
specified for this field (on the Sort tab). You can see this from the little arrow sort indicator in the column
header. You can change the sort order of the table with two simple clicks.

Do the following:

l Right-click in the column Salesperson, and then click Sort.

The order of the columns remains the same, but it is now the sort order defined for the field Salesperson
that determines the order of the values in the table. Note how the sort indicator (arrow) has moved to the
Salesperson column.

The sort priority can also be set on the Sort tab of the Properties dialog.

Moving a column
Suppose you want the dimension Salesperson to the left of the Country column.

Do the following:

1. Click the Salesperson header and drag the column to the desired position.
The selected column is highlighted and the target is marked with an arrow while you are dragging.
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2. Release the mouse button.
The dimension Salesperson is now placed further to the left.

Visual cues
You can use visual cues to select expression values in the table. Values belonging to different value categories
can be given separate colors and/or font styles. Now you will learn to highlight certain values.

Do the following:

1. Right-click the straight table and choose Properties.

2. Go to the Visual Cues tab.
The Sales expression is available, and there are four value categories to choose between: upper, normal,
lower and text.

3. To select all the expression values above 10,000, type 10000 in the Upper> box.

4. To apply a red color to the values belonging to the upper value category, click the Text button, choose a
red color from the color map and click OK.

5. In addition, check Bold.

6. Click OK.
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All expression values above 10,000 are now red.

Selections in table charts
It is possible to make selections in pivot tables and straight tables as well. Clicking a column containing a chart
expression implies an indirect selection of those values in the dimension columns (rows) that are used to
calculate that expression value.

Do the following:

1. In the straight table, click the value 2008 in the Year column. The effect is the same as selecting 2008 in
the list box Year.

2. Clear your selections.

3. Click the value $11,379 in the column Sales.
You have now selected the value 2009 in Year, the value Pakistan in Country and Ann Lindquist in
Salesperson.

4. Clear your selections.

Dropdown select
If you need to make more complex or multiple selections in a table chart there is yet another option, called drop-
down select. This feature makes it possible to turn a dimension column into a drop-down list with full selection
and search capabilities.

Do the following:

1. Right-click in the straight table, and click Properties.

2. On the Presentation sheet, under Columns, select Year. Select the check box Dropdown Select .

3. Repeat steps 1-2 for the Country and Salesperson columns.

4. Click OK.
You see that all three dimension columns have a drop-down icon to the right in the column header.

5. Click the icon for Year and a temporary list with all the years will appear. Press the Ctrl key and click the
years 2006, 2009 and 2010. Then release the Ctrl key.
The three years are now selected and the drop-down list is closed.
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6. Click the drop-down icon in the Country column. In the list, type sw.
This text search will result in Sweden, Switzerland and Swaziland.

7. Press Enter.
Now you see available information for these countries. Only Sweden and Switzerland are shown in the
straight table because there are no sales in the other country.

8. Clear your selections.

Moving the pivot table and the straight table to a new sheet
The Sales sheet is looking crowded. To improve the overview, you will create a new sheet for the tables.

Do the following:

1. From the Layout menu, choose Add Sheet.
The tab Sheet 3 appears to the right of the Sales tab.

2. Right-click somewhere in the new sheet and choose Properties.

3. On the General tab, type Tables for Title, and click OK.

4. Go back to the Sales sheet.

5. Drag the pivot table to the Tables sheet, and release the mouse button when the cursor turns into a white
arrow.

6. Drag the straight table to the Tables sheet using the same procedure as in step 5.

7. Click the Tables sheet.
The pivot and straight tables are placed in the same position as on the Sales sheet. You may want to
move them to a different position on the sheet.

There is now room for additional charts on the Sales sheet.

Auto Minimize
To improve the overview on the Sales sheet even more, you can set some of the charts to automatically
minimize, meaning that only one of the them will be shown at any one time.

Do the following:

1. On the Sales sheet, right-click the Sales Forecast chart and go to the Caption tab of the Properties
dialog.
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2. Check Auto Minimize and click OK to close the dialog.

3. Repeat steps 1 and 2 for the bar chart called Drill-down.
If a chart is minimized, you can right-click its icon to open the Properties dialog.

4. Restore the pie chart by double-clicking its icon.
Note that the other charts on the sheet are minimized and shown as icons.

5. Now restore the Drill-down chart.
The pie chart is automatically minimized.

You can also make this change for several charts at once.

Do the following:

1. “Paint” a rectangle with the mouse around the charts (or icons of minimized charts) that you want to
modify.
Their captions or minimized icons turn green.

2. Right-click one of the selected charts or icons to open the Properties dialog for all the objects.
Note that the dialog in this case is limited to the Font, Layout, and Caption tabs.

3. On the Caption tab, check Allow Minimize and Auto Minimize.
If it is already selected, this means that one of the charts that you selected already has the Auto
Minimize setting. In this case, you must first clear the Auto Minimize check box and then select it again.

4. Click OK.

2.6 More chart types
This lesson introduces additional chart types. The line chart is useful for showing trends or changes. Working
with a combo chart, you can combine the features of the bar chart with those of the line chart. As for scatter
charts, they show pairs of values from two expressions. Gauge charts are used for displaying one specific value.
You will also encounter drill-down functionality in a hierarchic bar chart created out of a field group. At the end
of the lesson, you will print a chart.

Creating a line chart
Instead of being displayed as bars, data can be presented as lines between value points, as value points only or
as both lines and value points. Line charts are useful for showing changes or trends. You will create a line chart
illustrating how the sales per customer have changed over the years.

1. On the Sales sheet, click Create chart on the toolbar.

2. Select Line Chart, and type Customer as Window Title.

3. Click Next >.

4. On the Dimensions page, add Year and Customer to Used Dimensions box.
It is important that Year comes before Customer in this example. Use the Promote and Demote buttons
to define the order.

5. Click Next > to create an expression in the Edit Expression dialog.

6. In the fields Aggregation and Fields, create the expression Sum(Sales), then click Paste.

7. Click OK.
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The Edit Expression dialog closes and you are back on the Expression page.

8. Type Sales for Label.

9. Under Display Options, select Smoothin the Line drop-down box.

10. Click Finish.

11. Clear your selections.
When no values are selected, the chart looks a bit overcrowded; as soon as you make a selection, though,
the trends will appear very clearly.

12. In the list box Customer, select Atlantic Marketing, and study the result.

The line chart shows the sales fluctuation for the customer Atlantic Marketing.

14. Clear your selections.

15. In the list box Salesperson, select John Doe.
You see that John Doe has had business contacts with Carlsborg since 2005, and that the company Mary
Kay has meant a lot to his career so far. You also see that he was not very successful with Captain Cook’s
Surfing School.

16. To find out if Captain Cook’s Surfing School is still a customer after all, select it in the list box Customer.

17. In the list box Customer, right-click Captain Cook´s Surfing School and click Clear Other Fields.
No need to worry: the surfing school is still a customer, even though it purchased less during 2010 and
2011. In the pivot table that you moved to the Tables sheet you can study the exact data.

18. Clear your selections and minimize the chart.

Adding an expression to a bar chart
Suppose you would like to see how the number of customers is related to the population of a certain country.

Do the following:

1. Click the Geography sheet where you find a bar chart called Population.

2. Copy the chart to the Sales sheet.
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3. On the Sales sheet, right-click the chart and choose Properties.

4. On the General tab, for Window Title , type Customers/population.

5. Check Show Title in Chart, and type Customers/population in this box too.

6. On the Expressions tab, click Add to open the Edit Expression dialog.

7. Compose Count (distinct Customer) by selecting Total Count as Aggregation and Customer as
Field.

8. Check Distinct to count customer names that occur several times only once. Then click Paste.

9. Click OK to close the Edit Expression dialog.

10. Select the expression Count (distinct Customer), in the Label box, and type Customers (nr).

11. Select the expression Population and in the Label box, type Population (mio).

12. Click OK.
Study the chart. You have set both population and number of customers as expressions, but only the
population is shown. The reason for this is that both expressions are shown on a single axis, and that the
magnitude of the numbers of the two expressions differs so much that the number of customers is not
visible.

13. Right-click in the chart, and choose Properties.

14. On the Axes tab, select Customers (nr), and under Position, click Right (top).

15. Click OK.
The chart shows the ten countries with the biggest population and the number of customers in these
countries.

Turning the bar chart into a combo chart
You will now turn the bar chart above into a combo chart. In a combo chart, you can combine the features of
the bar chart with those of the line chart, for example by showing one expression as bars and the second as lines
and/or symbols.

Do the following:
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1. Right-click the bar chart Customers/population, and choose Properties.

2. On the General tab, click the combo chart icon.

3. Click the Expressions tab.
The expressions Population (mio) and Customers (nr) are listed in the Expressions box.

4. Select Population (mio), and under Display options, check Bar. Clear the Line check boxes .

5. Select Customers (nr), and under Display Options, check Symbol and Line. In the list, select Smooth
Line.

6. Click OK.
Instead of displaying both expressions as bars, the chart now shows how the population and the number
of customers in different countries are related to each other.

Turning the combo chart into a scatter chart
When showing data where each instance has two numbers, like in this case (each country has a number of
customers and a population), you might find the scatter chart a useful representation form.

Do the following:

1. Right-click the combo chart, and select Properties.

2. On the General tab, click the scatter chart icon.

3. On the Dimension Limits tab, clear the Restrict which values are displayed using the first
expression check box.

4. Click OK.
The dimension (Country) is represented by the symbols, and the expressions (Population and
Customers) are displayed on the axes. You immediately see that some of the countries are placed far out
to the right on the x-axis, which means that their populations are far above the average. In two countries
we already have more than 10 customers.

5. Select the countries with the most customers by “painting” the area in the chart using the mouse button.
You see that the countries are Japan and USA, and how population and number of customers are related
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to each other.

6. Clear your selections and minimize the chart.

Creating a scatter chart from scratch
You will now create a similar scatter chart, showing population and population growth.

Do the following:

1. On the Geography sheet, click on the toolbar.

2. On the General page, type Population Growth for Window title and Show Title in Chart.

3. For chart type, click the scatter chart icon and click Next>.

4. On the Dimensions page, move Country to the column of displayed fields and click Next>.

5. Choose Next >.
The Expressions page of the scatter chart differs from that of the other charts.
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6. Choose Pop. Growth for X, and Population(mio) for Y.

7. Click Finish.
Your new scatter chart is finished. Move it, size it, and try it by making selections.

8. Clear your selections and minimize the chart.

Creating a gauge chart
Quite often you want to view the changing value of a single measurement as you change your selections. For this
purpose the gauge chart is ideal. QlikView offers a wide range of gauge charts for graphic visualization of
values. In this section we will create a simple circular gauge chart indicating average gross margin for whatever
set of customers and/or periods that we have selected.

Do the following:

1. On the Sales sheet, click on the toolbar.

2. On the General page, type Gross margin for Window title and Show Title in Chart.

3. For chart type, click the gauge chart icon and click Next>.

4. On the Dimensions page, do nothing at all, as gauge charts are calculated without any dimensions
resulting in one single value over the entire data set.

5. Click Next > to create an expression in the Edit Expression dialog.

6. Select Average as Aggregation and Gross margin as Field and click Paste.
The expression Avg([Gross Margin]) is created. Click OK.

7. Label the expression Gross Margin, then click Next > and Next >.

8. The circular gauge is preselected on the Style page, leave it like that, and click Next >.

9. On the Presentation page, under Gauge settings, type 3000 for Max.

10. Change Segment 1 to red and Segment 2 to green by clicking the color matrix.
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11. Still on the Presentation page, make sure that Show Scale is checked, and select 7Major Units, Show
Labels on Every1Major Unit and 2Minor Units per Major Unit. Click Next > several times until you
reach the Caption page.

12. On the Caption page, check Auto Minimize, and click Finish.
You now see your circular gauge with one red and one green segment.

Let us do a bit of analysis!

15. Clear your selections.
The gauge now shows the average gross margin for all customers.

16. In the Customer list box, choose Atlantic Marketing.
This is a good customer!

17. Select Barley Foods instead.
Room for improvement!

Working with drill-down functionality
A dimension used in a chart is usually equivalent to a single field, for example Year. However, you will sometimes
encounter charts created out of field groups. These charts can be of two types, drill-down or cyclic. In a drill-
down chart, the field group defined usually consists of fields forming a natural hierarchy, for example Year,
Quarter, Month. The Sales sheet in your document contains a minimized chart with drill-down functionality.

Do the following:

1. Clear your selections.

2. Click the Sales sheet, and double-click the minimized chart Drill-down.
The chart, showing the sum of sales per year, looks like any other bar chart. However, as soon as you
make a selection causing the field Year to have only one possible value, you discover its drill-down
character.

3. In the chart, click the 2008 bar.
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An ordinary chart would now display one bar, representing the sum of sales for 2008. This chart,
however, shows the sum of sales for each quarter of the year 2008. This is due to the fact that it holds a
drill-down group as dimension. Year is the first field in the group and when selecting a single year, the
display changes to the second field being Quarter.

4. Click the bar representing the fourth quarter.
The chart shows the sales for each month of the selected quarter. Month is the third, and last, field in the
field group. Note the selections in the Current Selections box on the same sheet. Keeping track of
selections is very important when working with drill-down charts.

5. To go back in the hierarchy, click next to the field name.
As soon as more than one value becomes possible in the fields further up in the hierarchy, the chart is
automatically drilled back up.

Copying to clipboard and printing
All sheet objects can be copied as images to the clipboard. Charts and tables can be printed. It is also possible to
export the data values of charts and tables to the clipboard.

Copying a sheet object to clipboard
Do the following:

1. Right-click a any chart on the sheet, select Copy to Clipboard, and then click Values.
The values from the chart can be pastes into another program, such as Word.

2. Open a blank document in Word, and click Paste (in Word).
You now see the values from the chart in the Word document.

Instead of selecting Values you can select Image to copy the chart as an image to paste it into other programs
as an image, or Object to be paste the chart into another QlikView document.

Printing
If you want to print a chart, right-click the chart and select Print.

QlikView Tutorial - QlikView, April 2019 70



2   Working with QlikView

It is also possible to print the entire QlikView document from the File menu or by clicking on the standard
toolbar. For more information, see the QlikView online help..

To quickly print charts that are printed often, you can display a little print icon in the caption of the chart. This is
done under Special Icons on the Caption tab in the Properties dialog of the chart.

2.7 Multiboxes, table boxes and input boxes
This lesson features the multi box, which allows you to show data in a very compact way, the input box, which
can be used for interactive input of data and the table box which presents data in table format.

The multi box
The multi box, or multiple drop-down list box, is a sheet object that shows several fields simultaneously in a very
compact way.

The multi box makes it possible to show a great number of fields on a single sheet to get a overview.

How results of selections are shown in multi boxes
The Geography sheet contains a multi box showing country information.

For each field in the multi box, there is a selection indicator telling you if the values of the field are selected,
optional or excluded.

A value will be shown in the multi box only if it is the single possible (optional or selected) one.

Do the following:

1. Clear all your selections.

2. In the Currency list box, choose Aus Dollar.
Most of the fields still have white selection indicators in the left column, and show nothing in the right
column. This means that these fields contain several optional values. Aus Dollar and Not known being the
only possible values in their respective fields, they are shown in the multi box.

3. In the Country list box, choose Australia.
Values appear in all the fields. The multi box allows you to display a great amount of information in a
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limited space.

Creating a multi box
Do the following:

1. Click the Customers sheet.

2. Clear your selections.

3. Click on the toolbar or choose New Sheet Object > Multi Box from the Layout menu.
The General page of the Multi Box Properties dialog now opens, where you can choose the fields to
display in the multi box.

4. For Title, type Customer info.

5. In the Available Fields list, select Customer and then click Add>.
The field Customer is moved to the column of displayed fields, which means that it will appear in the
multi box.

6. Press Ctrl while selecting a few more fields: Address, City, Country, and Zip.

7. Click Add> and then OK.
The multi box appears on your sheet.

Making selections in the multi box
Do the following:

1. Clear your selections.

2. In the field Customer, choose Gaston HiTech.
There are optional values in all the boxes.

4. Click the field Country.
Belgium and France are optional.
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5. The French address is the one you need, click France.
The requested information appears in the remaining fields of the multi box.

6. Right-click the multi box.
Have a look at the shortcut menu, then choose Properties. The Properties dialog of the multi box
contains tabs that look similar to those of the list box. Here you can make changes that affect the entire
multi box.

7. Close the Multi Box Properties dialog and right-click the field Customer in the multi box.
Look closely at the shortcut menu that opens. You will see that the commands in the second group (as
shown in the picture) apply to the field you have clicked on, whereas the other groups of options are the
same as for the entire multi box. These operate on all its fields.

Promoting a field
Maybe you would prefer to let the field Zip precede Country.

Do the following:

1. Click in the white area in the field Zip and press the mouse button while dragging upwards.
A blue arrow appears.

2. Release the mouse button when the arrow is above the field Country.

3. Clear your selections.

You can also change the order of the field using the Promote and Demote buttons on the General tab of the
Multi Box Properties dialog.
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The table box
The table box is a sheet object that shows several fields simultaneously. The contents are record-oriented in the
same way as a normal table, that is the contents of one row are logically connected. The columns of the table
box can be loaded from different input tables, which allows you to create a new table from the logically possible
combinations of the input tables.

At the first glance, the table box may look similar to the straight table, both are record-oriented, that is each row
contains a possible combination of data. However, there are fundamental differences between the two sheet
objects, the most important one being that table boxes cannot show calculated values.

Making selections in a table box
The sheet Geography contains a table box called Table Box. Just like the other sheet objects, the table box
immediately reflects selections made in other sheet objects.

Do the following:

1. In the list box Country, choose a few countries and study the result.
You can make selections in a table box by clicking any of the available field values or by “painting” an
area.

2. Select a range of values in the table box.
See how the contents change.

3. Clear your selections.

Creating a table box
Do the following:

1. Click the sheet Customer.
The sheet contains a multi box with the fields Customer, Address, City, Zip, and Country. You will now
create a table box with the same fields.

2. Click on the toolbar.
The General page of the New Table Box dialog appears on the screen.

3. For Title, type Customer info.

4. Double-click the fields Customer, Address, City, Zip, and Country. Use the Promote and Demote
buttons if you need to change the order of the fields, and then click OK.
A table box containing the selected fields now appears on your screen.

5. Size it until you see all the columns, and move it to an appropriate position.
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As you see, the field values found in one and the same row are logically connected just like in a straight
table.

Adjusting columns
The columns of the table box can be adjusted just like those of the other tables.

Do the following:

l To adjust a column, place the cursor on one of the vertical lines, then drag.

l To adjust the rightmost column, place the cursor as far to the right as you can, but within the border and
the scroll bar.

l To adjust all the columns, right-click in one of the columns, and choose either Fit Columns to Data or
Equal Column Width.

The shortcut menu of the table box has different appearances depending on whether you right-click
on the title bar or on a field. Field-specific commands such as Select Possible, Sort and so on are
either non-existent or dimmed when you right-click the title bar of the table box. The options in the
Objectmenu are equivalent to those in the shortcut menu of the currently active object.

Sorting the table box
Just like the straight table, the table box provides excellent possibilities for sorting.

Do the following:

1. Right-click the column header of the column Country, then choose Sort.
Customer is still the first column of the table box, but the values are now sorted according to the sort
order of the field Country. Note how the sort indicator in the table header has changed position. Since
this sheet mainly contains customer information, it makes more sense to have the table sorted by
customer, though.

2. Double-click the header of the column Customer.
The table is now again sorted according to the sort order of the field Customer.
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The sort order of the different fields can be set on the Sort tab of the Table Box Properties dialog.
Here you can also change the sort priority of the columns by means of the Promote and Demote
buttons.

Printing a table box
Suppose you want to print a list of all the French customers.

Do the following:

1. Clear your selections.

2. On the Customers sheet, in the list box Country, choose France.
The table box now shows all the customers that have offices in France.

3. Right-click the table box Customer info, and choose Print.
The Print dialog opens.

4. Click Print Preview to have a look at the list over French customers.

5. Click Print

It is also possible to print the document from the File menu or by clicking on the toolbar.

Exporting values from a table box
Instead of printing the table box, you can export its contents to a file.

Do the following:

1. Right-click the table box, and choose Export.
In the dialog that opens, qvo is preselected as type of file. This is a QlikView-specific type, which can be
freely associated with any program, for example Excel.

2. For File name, type Customers in France.qvo.

3. Click Save.
You can now open the Windows Explorer (Window 7) or File Explorer (Windows 8.1 and 10) and double-
click the qvo file to open it with Excel.

4. Close Excel and go back to QlikView.

Using an input box
Sometimes there is a need to enter data interactively into the QlikView document. It is normally not possible to
change data in the fields (list boxes and so on) interactively. However, in QlikView you can use variables, which
can be changed at any time. The typical way of entering data in a variable is through the input box.

Entering data in an input box
In this section we will use an input box to enter a forecasted sales increase and see the result in a chart.
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Do the following:

1. Clear your selections.

2. Go to the Geography sheet where you find an input box and a text object.

3. Select the input box and the explanatory text object below. Move both objects to the Sales sheet.

4. Click the Sales sheet.
The input box and the text object are now found on this sheet.

5. Double-click the minimized chart Sales Forecast.
Sales Forecast shows sales per year as well as a red bar for a forecast of next year’s sales to the right. The
forecast is calculated using an expression based on the sales in the current year, increased by a percent
factor in a variable called Increase%.
This percent factor is the variable shown in the input box. It is currently set to 10 percent. Since we are
optimistic about sales, we will now raise the forecast to 20 percent sales increase.

6. Click in the area to the right of the “=” in the input box.
The figure ”10” is marked.

You are now in edit mode for the input box.

7. Type 20 and press Enter.
The value of the variable has changed and the chart is recalculated. You can see how the Forecast bar
grows higher.

8. Minimize the chart.
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Input box constraints
In principle variables in input boxes can hold any data. The document designer often sets limits to what is
allowed to enter. In the example in front of you a non-numeric value would not make sense, so this input box has
a constraint only allowing input of numbers between -50 and 50.

Now you will try to enter a value outside the constraints.

Do the following:

1. Click inside the input box and type 99. Press Enter.
The input box will not accept this value as it falls outside the set constraints. You will remain in edit mode
in the input box with the old value marked.

2. Type 10 and press Enter and you are back where you started.
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2.8 Buttons, text objects and line/arrow objects
In this lesson, you will learn how to create buttons, text objects and line/arrow objects. These objects are not
displaying any data. Instead they are used to enhance the layout and usability of the document.

Buttons are used for carrying out commands in an easy way, or for exporting data. Text objects also have
several areas of use. Among other things, you can improve the appearance of your document by displaying text
or pictures in text objects. Lines and arrows can be used for different layout purposes.

The text object
Text objects can be used in several different ways, for example for displaying explanatory text or pictures or for
creating multi-colored sheet areas.

Creating a text object
You will use text objects to display text and images for the layout of a welcome page for the document.

Do the following:

1. On the Layout menu, choose Add Sheet.
A new sheet appears.

2. Right-click somewhere in the new sheet to open the Properties dialog.

3. On the General tab, type Welcome for Title box, and click OK to close the dialog.

4. Click on the design toolbar.
The New Text Object dialog opens.

5. Type QlikView Tutorial in the Text area.

6. Under Background,set the Transparency slider to 100 %.

7. On the Font tab, select 36for Size and choose a grey color.

8. Click OK to close the dialog.

9. Size and position the text object on the sheet.

Using a function in a text object
Now, you will create another text object showing information about the latest document.

Do the following:

1. Click on the design toolbar.
The New Text Object dialog opens.

2. Type ='Last update: '&reloadtime().
This is an expression for a calculated text. It delivers the text “Last update:” followed by the timestamp of
the last reload of the document. The timestamp is calculated by the function reloadtime().

3. Under Background,set the Transparency slider to 100 %.

4. On the Font tab, select a font of your choice, and click OK to close the dialog.

5. Size and position the text object on the sheet.
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Using the text object to include an image
Now you will create a third text object, showing an image.

Do the following:

1. Click on the design toolbar.
The New Text Object dialog opens. This time you will leave the Text area empty as this text object
should not show any text.

2. Under Background, select Image and click Change.

3. Browse to the folder Working with QlikView, select the file QlikViewWater. gif and click Open.

4. Click OK to close the dialog.

5. Position the text object on the sheet.

The line/arrow object
Line/arrow objects can be used for example for dividing the sheet into different areas or to visualize relations
between certain sheet object. You will use a horizontal line to enhance the layout of the Welcome sheet.

Do the following:

1. Click the Welcome sheet.

2. Click in the design toolbar.
The New Line/Arrow dialog opens.

3. Set Line Weight to 1 pt.

4. On the Layout tab, select Bottom in the Layer group, and click OK.
A black horizontal line appears on the sheet.

6. Enlarge the line/arrow object.

7. Place it above the text object showing the reload date.

It could be that the line/arrow object overlaps the text objects next to it. In this case you can either
make the line/arrow object narrower, or you can rearrange which layers the text objects reside in.
To make a partly hidden text object appear on top of the line/arrow object, open the properties
dialog of the text object and choose Normal in the Layer group on the Layout tab.

The button
Buttons can be used in QlikView to perform commands or actions, for example exporting data to files or
launching other documents. For more information, see the QlikView online help.

Creating a launch button
You will now create a button on the Welcome sheet.

Do the following:
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1. On the Welcome sheet, click on the design toolbar.
The New Button Object dialog opens.

2. On the General tab, type Go to QlikView Homepage in the Text box, and choose a green color for the
text.

3. On the Actions tab, click Add.
The Add Action dialog opens.

4. From the External group, choose Open URL.

8. Click OK to close the Add Action dialog.

9. On the Actions tab, type www.QlikView.com for URL, and click OK.

10. Size and position the button on the sheet.

11. Try clicking your new button.
The web page opens in your regular browser.

Creating an export button
You have already learned how to export data from a table box. It is also possible to use a button to export data
from specific fields.

Do the following:

1. On the Sales sheet, click on the design toolbar.
The New Button Object dialog opens.

2. Type Export in the Text area and choose a green color for the button.
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3. On the Actions tab, click Add.
The Add Action dialog opens.

4. From the External group, choose Export and click OK.

5. Click Setupto open the Export Action Settings dialog.
All the fields in the document are listed under Fields.

10. Double-click the fields Customer, Country, Salesperson, Year, and Sales to add them to the Export
Lines list.

11. Check Include Labels, and choose Records.

12. Click OK twice to close the dialogs.

13. Select a few values on the Sales sheet, and then click the Export button.
The possible values in the specified fields have been copied to the clipboard. To see the result, open
another software, for example Excel, and click Paste.

Exporting data to a file
You can also export the data to a file, similar to exporting values from a table box in the previous lesson.

Do the following:

1. Right-click the Export button, and choose Properties.

2. On the Actions tab, select Export, and click Setup.
The Export Action Settings dialog opens.

3. Under Export to, choose File.
The Export File dialog opens.

4. Browse to the location of your Tutorial. qvw file, and type a name, for example Export.

5. Select Comma Delimited (csv, txt) as file type.

6. Click Save to close the Export File dialog.
You see the path to the file on the Export Action Settings dialog.

8. Click OK twice to close dialogs.

9. Test the functionality of your button.
Every time you click the Export button, all combinations of the possible values of the specified fields will
be copied to this file.

Launching an export application
If you want the application to be launched as soon as you click the export button, you can specify this by
creating a Launch action.

Do the following:

1. Right-click the Export button, and choose Properties.

2. On the Actions tab, select Add.
The Add Action dialog opens.

3. From the External group, select Launch and click OK.
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The Actions tab opens, displaying settings relevant to the Launch action.

4. Click Browse next to the Application box and browse to your export file Export.csv. Make sure that All
files are selected as file type in the Select Program dialog.

5. Click OK to close the Button Properties dialog.

6. Select a few values on the Sales sheet again, then click the Export button. The file Export.csv, containing
your exported data, opens.

7. Close the export file and clear your selections.

If you want your newly created buttons to look like the one on the Geography sheet, you can use the
format painter to copy the format from one button to the other.

2.9 Sliders, current selection objects and bookmark objects
This lesson features a few additional types of sheet objects which can be used to make QlikView documents more
user-friendly. The slider/calendar object offers a graphical way of manipulating selections in a field or data in a
variable. The current selections box and bookmark objects makes it possible to move menu functionality to a
more visible position in the QlikView layout.

The slider/calendar object (in slider mode)
A slider allows you to make selections in fields or variables while showing the selection graphically. Slider objects
are very versatile and useful.

In this tutorial we are only showing one of their possible uses: to connect a slider object to a field. For more
information, see the QlikView online help..

A slider consists of several parts that can all be formatted and defined.

A Ticks

B Scale background

C Slider background

D Thumb tack

E Scroll arrows
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Slider objects can be used to control a field or one or two variables. In this example, we will use it for controlling
selections in the Month field.

Do the following:

1. Go to the Sales sheet.

2. Clear your selections.

3. Click on the design toolbar or right-click somewhere on the sheet and choose New Sheet Object >

Slider/Calendar Object.
The General tab of the New Slider/Calendar Object dialog opens.

4. Choose Month for Field, and Multi Value for Mode.

5. On the Presentation tab, choose Use Custom Scale. 

6. Select 12Major units, Labels on every1Major Units and 0Minor Units per Major Unit.

7. On the Sort tab, check Numeric Value.

8. On the Layout tab, check Use borders and ensure Solid is selected as the Border Style.

9. On the Caption tab, check Show Caption, and type Month for Title Text.
Click OK.
The slider object appears on your sheet. To show the ticks, you may need to size the slider object by
dragging its border.

10. In the Months list box, select the months 7, 8 and 9.
A thumb tack appears in the slider object.

13. Point at the thumb tack and drag it.
Note the pop-up showing the months corresponding to the current position of the thumb tack.

14. Release the mouse button.
The selections in the list box shift in line with the slider position.

15. Position the cursor on one of the slider thumb tack’s short ends. Click and drag.
The range of selections will narrow or widen accordingly.

16. Release the mouse button.
The new selection takes effect.

17. Clear your selections.
The thumb tack disappears from the slider object.

18. Position the cursor inside the slider area (between the arrows).
The thumb tack reappears.

Creating a current selections box
You learned about current selections boxes under Selections (page 13). A current selections box provides a quick
overview of the selections made in the document at any time.

Do the following:

QlikView Tutorial - QlikView, April 2019 84



2   Working with QlikView

1. Click the Customers sheet.

2. Click on the design toolbar or choose New Sheet Object > Current Selections Box.

3. On the General tab, check Use Column Labels, and click OK.
The current selections box appears on the sheet.

4. Now select a few values in the fields.
Note how your choices are reflected in the current selections box.

5. Clear your selections.

Creating a bookmark object
In the Bookmarks menu, you can create and use personal bookmarks that are stored on your own computers
as well as document bookmarks that are stored with the QlikView file. For more information, see the QlikView
online help.

However, it is sometimes more convenient to be able to handle bookmarks directly in the QlikView document. In
a bookmark object you can select existing bookmarks from a drop-down list and, depending on configuration,
add new and delete old bookmarks.

Do the following:

1. Click the Customers sheet and clear your selections.

2. Click on the layout toolbar or choose New Sheet Object > Bookmark Object.

3. On the General tab, type Bookmarks for Title , and click OK.
The bookmark object appears on your sheet.

6. Make a few selections in some list boxes and then click Add Bookmark in your new bookmark object.
The Add Bookmark dialog opens.

7. Type a name for the new bookmark and click OK.

8. Clear your selections.

9. Select your bookmark in the drop-down list in the bookmark object.
The selections made when you created the bookmark are restored.
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2.10 Document properties, user preferences and reload
In the previous lessons, you have been working with the different sheet objects. Among other things, you have
changed the appearance and behavior of the objects using their Properties dialogs. In this lesson, which is the
final lesson of this section Working with QlikView, you will learn how to change the properties of all the objects in
the document at the same time.

Furthermore, some settings that affect not only the current document, but all the work performed in QlikView,
will be introduced.

At the end of the lesson, you will learn how to update your document, that is how to reload data from the data
sources that contain the data shown in your QlikView document. You might say that this lesson is a stepping-
stone to the next part of the tutorial where you learn to create a document by loading data from different data
sources.

Setting document properties
Until now, you have been changing the properties of individual sheet objects. However, you will often find
yourself in a situation where you would like to give the same appearance to all the sheet objects of the document
or format several fields at the same time. You might want to set background colors for all the sheets in the
document. This is when the Document Properties dialog is useful. You can also use this dialog to attribute an
opening sound or an opening picture to your document.

Setting an opening sound
You can further improve your document by choosing a picture and/or a sound to be shown or played,
respectively, when the document is opened. You will now learn how to play a sound when opening the document.

Do the following:

1. In the Settings menu, choose Document Properties, and click the Opening tab.

2. Check Sound, and click Select.

3. Browse to the file tada.wav. It is located in the same folder as your tutorial file. Click Open.

4. Under Sound, click Play, then click OK.

5. Save the document.

Setting properties
Several of the tabs in the Document Properties dialog contain settings similar to those of the List Box
Properties dialog. The difference is that when you change the settings in the Document Properties dialog, all
the sheet objects containing the selected field are affected. The settings are either applied immediately or only on
new sheet objects that are created after the changes were made. For more information, see the QlikView online
help.

QlikView Tutorial - QlikView, April 2019 86



2   Working with QlikView

Choosing a different selection style
The selections in a QlikView document are by default visualized by a color coding: green for selected values,
white for possible values and grey for excluded values. This color scheme can be slightly modified, but the basic
colors will always remain. As an alternative, Windows check boxes may be used to show the logical state of a
value.

Do the following:

1. In the Settings menu, choose Document Properties.

2. On the General tab, select a different color scheme or a different style under Selection Appearance,
and click OK.

3. Make some selections to view the visualization in different object types.

Sorting all future list boxes containing a particular field
You can select to sort all list boxes that you create going forward, based on a specific field. In this example, list
boxes will be sorted on the field Area(km.sq).

Do the following:

1. In the Settings menu, choose Document Properties.

2. Click the Sort tab.
You recognize the sort options from the List Box Properties dialog, with the list of all the fields in the
document.

3. Select the field Area(km.sq), then check Numeric Value and select Descending.
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4. Click OK.

5. Create a new list box containing the field Area(km.sq) and note its sort order.

6. Delete the new list box.

Applying the same border settings to all the sheet objects
The Layout tab of the Document Properties dialog is identical with the corresponding tab in the List Box
Properties dialog. However, a setting changed here will affect the entire document. Let us give objects (except
buttons, text objects and line/arrow objects) a walled border with slightly rounded corners.

1. In the Settings menu, choose Document Properties.

2. Click the Layout tab.

3. Select the Use Borders, choose a style and width.

4. Click the Apply To button, and click OK.
The change is implemented throughout the entire document.

1. Revert to the original layout settings.

2. Save the document.
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Themes
Another even quicker way of applying changes to an entire document is by creating and applying a QlikView
theme. For more information, see the QlikView online help.

User preferences
The User Preferences dialog, found in the Settings menu, contains a number of settings concerning your way
of working with QlikView. Settings changed here remain the same regardless of the document you work with.
One example is the language of the QlikView interface that you can change here.

Checking your work
The folder Working with QlikView contains a file called TutorialFinal. If you want to, you can open this file to
compare it with the one you just saved.

Classroom training
More layout options and settings as well as design fundamentals and best practices for building good user
interfaces are covered in the classroom training course QlikView Designer I.

The classroom course QlikView Designer II - for advanced designers - presents charts with advanced display
options, more object types, complex calculations in objects and report generation.
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E-learning
Several e-learning courses are available free of charge at www.qlik.com, under Free Training.
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3 Creating a document

3.1 Introduction
In the Working with QlikView (page 11) part of the tutorial you learn how to work with an existing document. It
already contains data that you display in list boxes and other sheet objects. In this part, you will learn how to
create a QlikView document from scratch. Loading data and associating data tables are two of the main topics
to be treated. There will be a step-by-step presentation of the procedures.

It is possible to use a Getting Started Wizard in QlikView, but you will not use it in the tutorial. The exercises in
this part of the tutorial aim to educate you in scripting.

The source data files used in this part are found in the ...\Tutorials source\Creating a Document directory. The
sample represents a customer database of a fictive company.

3.2 Loading data into QlikView
A QlikView document is created by retrieving data from one or several sources, for example from a relational
database or from text files containing data tables. This retrieval is done by writing and executing a script, in
which the database, the tables and the fields to be retrieved are specified. The script can be generated
automatically with the tools included in QlikView. QlikView in itself is not a traditional database, you cannot add
or alter data in the source database. In this lesson, you will create a simple document consisting of one data
table.
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Data can be imported from text files, or from databases using the ODBC or OLEDB interface. The imported data, together
with the layout, can be saved as a QlikView document.

Looking at a delimited text file
The type of file that will be used in the examples is a csv (comma separated value) file, which uses comma as
delimiter. The fields (columns) can also be separated by other special characters, for example semicolon or tab.

One representation of a table - a comma separated file viewed in a simple text editor.

Comma separated value files and text files with other delimiters can often be imported to, and exported from,
spreadsheet programs.

Do the following:
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1. Start a spreadsheet program, for example, Excel.

2. Open the file Country1.csv from the ..\Tutorials source\Creating a Document\Data Sources directory (In
the Files of Type box, choose All Files.)

The contents of the file are logically a table, where each row, or record, describes a country and its
properties. The first line contains the column (field) names.

3. Close the spreadsheet program.

The comma separated file viewed in a spreadsheet program.

Creating a document and loading a text file into QlikView
Do the following:

1. Start QlikView.

2. On the Settings menu, choose User preferences and deselect Getting Started Wizard: Create a
new document at the bottom of the tab. Close the dialog.

3. Choose New on the File menu or from the toolbar.

4. Choose Save from the File menu. Save the file in the ..\Tutorials source\Creating a Document folder and
name it MyDocument.qvw.

5. Choose Edit Script from the File menu or from the toolbar.

The Edit Script dialog opens. The script will be created in the Edit script dialog. A number of rows
starting with SET have already been generated in the script pane. At the bottom of the dialog you will
find a row of tabs containing functions for script generation.
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6. Make sure that the check box Relative Paths is checked.

7. Choose Table Files.
This opens the Open Local Files dialog box, in which you can browse for the file you wish to load. Make
sure that the control Files of type: is set to All Table Files.

8. Open the file Country1.csv located in the ..\Tutorials source\Creating a Document\Data Sources
directory.
The file is now opened in the File Wizard, which interprets the contents of the file and helps you to load
the data into the script.

The file wizard interprets the file to be a comma separated (delimited) file using the Western European
(ANSI) character set. This is a correct interpretation. The wizard also state that the header size is none,
which means that the file contains no initial information to be omitted.

You want to use the field names Country > Capital etcetera. as labels, or heading in your file.

9. In the Labels drop-down, select Embedded Labels. The field names move to the top row and is marked
gray.

10. Since the program has made a correct interpretation of the file, you can click Finish.

11. A script similar to the one below has been generated in the Edit Script dialog:

Directory; LOAD Country, Capital, [Area(km.sq)], [Population(mio)], [Pop. Growth], Currency, Inflation,
[Official name of Country] FROM [Data Sources\Country1.csv]
(txt, codepage is 1252, embedded labels, delimiter is ',', msq);
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Study the script. In the LOAD statement, the fields of the selected file are listed. Some of the field names
are enclosed by square brackets. This is required when a field name contains spaces. The FROM
statement is followed by the path to the file. In the Tutorial we use relative paths.

The words SET, LOAD and FROM are highlighted. This means that they are keywords and
have a special meaning in the QlikView script.

The final parenthesis contains additional information about the file, specifying, among other things:

l File type - txt, ooxml, biff/xlsx etcetera.

l Character set: the character set used ANSI, or Windows 1252.

l Embedded labels: the first row of the file contains field names (column headings). If there are no
embedded labels, placeholders will be used as headings instead.

l Delimiter: semicolon, comma or tab are examples of characters separating the field value.

l msq stands for modern style quoting.

You recognize these terms from the file wizard.

If you save your changes while still in the Edit Script dialog before you reload it, you can
easily go back and make changes if the reload is not be successful. Your QlikView documents
can also be automatically saved just before the script is reloaded. On the Settings menu,
click User Preferences and then the Save tab. Select Save Before Reload and close the
dialog.

The Save Before Reload setting is recommended.

12. Click Reload.

The data is now loaded into QlikView, and a dialog box in which it is possible to select the fields to be
displayed is opened.

There are two ways to add fields to the list of displayed fields:
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l Double-click the field name. The field is immediately put in the list of displayed fields.

l Select a field and click Add > (If you want to select several fields, press Ctrl and then select the
fields).

13. Add the following fields to the list of displayed fields:

l Area (km.sq.)

l Capital

l Currency

l Population (mio)

If some field names is starting with “$”, deselect the check box Show System Fields below the field list.

You select fields to display on the current sheet from the Fields tab of the Sheet Properties dialog. Here you select
the fields to display on the current sheet.

14. Close the dialog and save your document.

15. Move and size the list boxes so that the data is entirely visible.
Your document looks similar to the "A simple QlikView document" shown below. All the fields in the
column Fields Displayed in Listboxes are displayed as list boxes on the active sheet.

If you want to add or remove fields, you can open the Sheet Properties dialog again. Right-click on the
sheet and click Properties from the shortcut menu.

16. Click on a capital in the Capital list box.
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Information is connected to the capital in the other list boxes, for example the currency used in that
country.

All the information refers to the countries, because every record in the table that was loaded
represents a country. Thus, clicking on Paris does not mean that you get the population of
Paris. It is still the population of France that is shown.

17. Clear your selections.

You have now created a document and loaded a text file into QlikView.

Relative paths and absolute paths
In the Tutorial we use relative paths, meaning that QlikView will look for files relative to the directory where the
current QlikView document is stored. To use relative paths, select the check box Relative Paths in the Edit
Script dialog. It is also possible to edit a path directly in the script.

An example of a relative path: ...\Tutorials source\Creating a Document\Data Sources.

A statement using a relative path is preceded by a directory statement in the QlikView script. For more
information, see the QlikView online help.

An absolute path, on the other hand, gives an exact specification of the location of the file. If you move the file to
another location (for example to a user directory or to another hard disk), the program will no longer be able to
find related files and run the script.
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An example of an absolute path is C:\Program data\QlikTech\QlikView Tutorial\English\Creating a
Document\Data Sources.

Saving, closing and exiting
If you don’t want to turn to the next lesson right away, you can close the document. You should also save the
document, since the following lessons are based on the work you have done so far.

3.3 Associating data from many tables
What you usually want to do is to load and associate data from a number of tables. In this lesson, you will be
familiarized with QlikView's way of automatically associating related tables. You will also learn how to rename
fields to assure or prevent associations.

Associations
If you have two tables listing different things, for example, if you have one list of customers and one list of
invoices, and the two tables have a field (column) in common, for the customer number, this usually means that
there is a relationship between the two tables.

If such a relationship exists, associations are made between the fields that are common to the tables. QlikView
assumes that the two fields are one and the same thing, and the two fields are treated as one. Such a field
connecting two or more tables is called a key.

There are two basic rules for associations:

l For two fields to be associated, they need to have the exact same name (case sensitive). Name and name
are not the same and will not be associated. The numbers 123 and 00123 are the same and are
associated.

l If a certain field has the exact same value in several different input tables, QlikView will treat it as one
value and also assume that the records (rows) containing the value should be associated. For two field
values to be associated, they either need to
– have exactly the same spelling (case sensitive), or
– have exactly the same numeric value

For a further illustration of the basic rules, study the following example:

Table 1: Table 2: Table 3:

Name Number Number Age Name ID

John 1 3 28 Phil ab

Phil 2 4 35 john xy

Betty 5 2 42
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In Table 1 and Table 2, the field Number has the value of 2. Which means that Phil is assumed to be associated
with the age 42.
In Table 1 and Table 3, the field Name has the value of Phil. Which means that Phil is assumed to be associated
with the number 2 and the ID ab. John in Table 1 is not the same as john in Table 3, so there is no association.

An association means that links are built between the fields in the tables, so that logical connections can be
studied. This way several tables from one or several databases can be included in the QlikView logic
simultaneously.

Loading and associating a second table
In this lesson, you will load an additional table representing a list of customers. The country table and the
customer table will be associated through the common field Country. As a result of this association, you can
study customers registered in different countries and the relation between country properties and customer.

The new table is found in an Excel file, you load it in the same easy way as a text file.

Do the following:

1. Start QlikView and open the file MyDocument.qvw.

2. Click Edit script.

3. Place the cursor at the end of the script and press Enter to get an empty row.

4. Click Table Files and open Customer.xlsx

In the file wizard, note that Excel (xlsx) is set as file type this time, and that the Tables box
contains the name of the worksheet. This Excel document contains only one worksheet. If
there had been several sheets or named tables, the Tables box would have made it possible
to choose from which one of them data should be retrieved.

5. In the Labels drop-down, select Embedded Labels.

6. Click Finish.

Your script will now look similar to the one below:

Directory; LOAD Country, Capital, [Area(km.sq)], [Population(mio)], [Pop. Growth], Currency, Inflation,
[Official name of Country] FROM [Data Sources\Country1.csv] (ooxml, codepage is 1252, embedded
labels, delimiter is ',', msq); Directory; LOAD [Customer ID], Customer, Address, City, Zip, Country FROM
[Data Sources\Customer.xlsx] (ooxml, embedded labels, table is [CUSTOMER$]);
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Study the script. You see that both Country1.csv and Customer.xlsx contain a field named Country.
QlikView will associate the two tables using this field, according to the association rules described above.

7. Reload the script.
The dialog in which you select the fields to display now appears. The fields from the file have been added
to the column of available fields. The field Country has been associated with the previously loaded fields
with the same field name. Country is now a key field, which is symbolized by the small key icon in front
of if.

8. Add the fields Customer and Country to the column of displayed fields.

9. Close the dialog and save your document.

It is now possible to click on a capital and find the customers that reside in the country of this capital. At
the same time, they are found in the customer register. This is possible although the fields Customer and
Capital are found in different tables. The only prerequisite is that there is a field, Country, common to
both tables.

10. Select Astana, the capital of Kazakhstan.

The fictive company has two customers in Kazakhstan.

11. Clear your selections.

You have now built a simple QlikView document containing data from two tables. Several tables can be
linked (associated) this way, which makes it possible to study complex relationships in data from many
tables.

Renaming fields
Associations between tables in QlikView are made using key fields that are common to the tables. The criterion
for two fields to be associated (to be treated as one and the same field) is that they have the same name.

Renaming fields to stop or create associations is an important part of creating a QlikView document. Fields that
should be associated do not always have exactly the same name in different tables. Fields that you do not want
to associate might have the same name. Renaming fields is a common procedure when building the QlikView
data structure.

Do the following:

1. Click Edit Script.

2. Place the cursor at the end of the script and press Enter to get an empty row.

3. Click Table Files and open the file Transact.csv.

4. In the file wizard, make sure that Delimited is set as the file type, Comma as delimiter and that
Embedded Labels is selected.

In the file Customer.xlsx that we loaded before, there was a field named Customer ID. The new file
contains a field named ID Customer. These two fields should be associated and treated as one. To make
the association you must rename one of the fields.

5. Click in the ID Customer table header, then type the new name Customer ID.
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Make sure not to forget the space between the words: any misspelling prevents QlikView from
interpreting the fields as being one and the same.

6. Press Enter the name of the field has been changed.

7. Click Finish.
The automatically generated script looks similar to the one below:

Directory; LOAD Country, Capital, [Area(km.sq)], [Population(mio)], [Pop. Growth], Currency, Inflation,
[Official name of Country] FROM [Data Sources\Country1.csv] (txt, codepage is 1252, embedded labels,
delimiter is ',', msq); Directory; LOAD [Customer ID], Customer, Address, City, Zip, Country FROM [Data
Sources\Customer.xlsx] (ooxml, embedded labels, table is [CUSTOMER$]); Directory; LOAD [Transaction
ID], Year, Month, Day, [Salesperson ID], [Product ID], [Serial No], [ID Customer] as [Customer ID], [List
Price], Sales, [Gross Margin] FROM [Data Sources\Transact.csv] (txt, codepage is 1252, embedded labels,
delimiter is ',', msq);

The line [ID Customer]as [Customer ID] has appeared as a result of the change you made in
the file wizard, and means that the field [ID Customer]will be loaded into QlikView with the
name Customer ID (thus assuring the necessary association).

8. Reload the script.

9. Add one field from the file Transact.csv to the column of displayed fields, for example Sales.

10. Close the dialog and save your document.

You have now loaded three different tables. By associating the tables in the way described, QlikView
allows you to find all the relevant information from all the tables at the same time - using a single click.

11. Select Finland in the Country list box. The program immediately provides the geographical data stored
in the country tables - but also displays the names of the customers residing in Finland, as well as the
sales values related to them.

12. Clear your selections.

It is easy to associate tables in QlikView. As a result, it is possible to link fields and tables that
should not be linked. If this is done, QlikView will give you irrelevant results. Think carefully
before assigning field names to fields of different tables, thereby defining the associations.

Saving, closing and exiting
If you don’t want to turn to the next lesson right away, you can close the document. You should also save the
document, since the following lessons are based on the work you have done so far.
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3.4 Concatenating tables
Different tables can be associated, but tables can also be merged. If two input tables are lists of the same things,
but contain different values, for example if one is a list of countries in Europe and the other one a list of
countries in North and South America, the second table can be seen as a continuation of the first. The tables
should then be concatenated.

Automatic concatenation
If two tables that have exactly the same set of fields are loaded, QlikView automatically treats the second table as
a continuation of the first. This is called concatenation of tables.

Any number of tables can be concatenated into one table.

Your QlikView document retrieved data from a file with a limited number of countries. The ..\Tutorials
source\Creating a Document\Data Sources directory contains a second file listing countries, the field names
correspond exactly to those of the already loaded Country1.csv. When you load the second file, the two tables
will be automatically concatenated.

Do the following:

1. Open your file MyDocument.qvw and open the Edit script dialog.

2. Position the cursor after the LOAD statement loading the file Country1.csv (all statements end with a
semicolon) and press Enter to get an empty row. The order of the load statements is arbitrary, but you
get a better overview of your script by keeping the country files together.

3. Click Table Files and open Country2.csv.

4. In the File Wizard, make sure that Delimited is set as the file type, Comma as the delimiter and that
Embedded Labels is selected.

5. Click Finish.

The added script should look similar to this:

Directory; Load Country, Capital, [Area(km.sq)], [Population(mio)], [Pop. Growth], Currency, Inflation,
[Official name of Country] FROM [Data Sources\Country1.csv] (txt, codepage is 1252, embedded labels,
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delimiter is ',', msq); Directory; LOAD Country, Capital, [Area(km.sq)], [Population(mio)], [Pop. Growth],
Currency, Inflation, [Official name of Country] FROM [Data Sources\Country2.csv] (txt, codepage is 1252,
embedded labels, delimiter is ',', msq); Directory; LOAD [Customer ID], Customer, Address, City, Zip,
Country FROM [Data Sources\Customer.xlsx] (ooxml, embedded labels, table is CUSTOMER$); Directory;
Load [Transaction ID], Year, Year as YearForecast, Month, Day, [Salesperson ID], [Product ID], [Serial No],
[ID Customer] as [Customer ID], [List Price], Sales, [Gross Margin] FROM [Data Sources\Transact.csv] (txt,
codepage is 1252, embedded labels, delimiter is ',', msq);

The sets of fields in Country1.csv and Country2.csvare exactly the same further below.

6. Reload the script.
The fields you selected last time are already in the column of displayed fields. No new fields have
appeared in the list of available fields. Only the field values of Country2.csv have been added to the
corresponding fields of Country1.csv.

7. Click OK and save your document.

At a first glance, your document will look very much like it did before. However, there are more entries in
most list boxes. Some list boxes may have become wider or obtained scroll bars due to longer field
contents.

Forced concatenation
Sometimes you want to concatenate tables also when they have different sets of fields. QlikView will then not
automatically concatenate the two tables: you need to use the concatenate statement, which concatenates a
table with the last created logical table.

In the Automatic concatenation section, two tables with identical sets of fields, Country1.csv and Country2.csv,
are concatenated. There is also a third file, Country3.csv that contains only a subset of the fields. All three files
are lists of countries. Furthermore, they contain different countries, so it is certainly relevant to concatenate the
three files into one logical table.

The values of the missing fields in the concatenated table will be NULL, QlikView will treat these fields as having
no value.

Do the following:

1. Open Edit script.

2. Position the cursor after the statement loading Country2.csv.

This time the order of the statements is not arbitrary, because the concatenate statement
forces concatenation with the last created logical table in the script.

3. Click Table Files and open Country3.csv.

In the File Wizard, make sure that the wizard has made a correct interpretation and click Finish. This
generates a script similar to the one below:
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Directory; Load Country, Capital, [Area(km.sq)], [Population(mio)], [Pop. Growth], Currency, Inflation,
[Official name of Country] FROM [Data Sources\Country1.csv] (txt, codepage is 1252, embedded labels,
delimiter is ',', msq); Directory; LOAD Country, Capital, [Area(km.sq)], [Population(mio)], [Pop. Growth],
Currency, Inflation, [Official name of Country] FROM [Data Sources\Country2.csv] (txt, codepage is 1252,
embedded labels, delimiter is ',', msq); Directory; LOAD Country, [Official name of Country], [Area(km.sq)]
FROM [Data Sources\Country3.csv] (txt, codepage is 1252, embedded labels, delimiter is ',', msq);

Directory; LOAD [Customer ID], Customer, Address, City, Zip, Country FROM [Data Sources\Customer.xlsx]
(ooxml, embedded labels, table is CUSTOMER$); Directory; Load [Transaction ID], Year, Year as

YearForecast, Month, Day, [Salesperson ID], [Product ID], [Serial No], [ID Customer] as [Customer ID], [List
Price], [Sales, [Gross Margin] FROM [Data Sources\Transact.csv] (txt, codepage is 1252, embedded labels,
delimiter is ',', msq);
Study the script. The three fields in the file Country3.csv are all found in Country1.csv, which constitutes
the last created logical table. However, since the set of fields is not exactly the same, you need to add the
word concatenate for the tables to be merged.

4. Position the cursor in front of the load statement that loads Country3.csv and type CONCATENATE. The
word concatenate will turn blue, since it is also a keyword. Make sure there is a space between
concatenate and load.

... CONCATENATE LOAD Country, [Official name of Country], [Area(km.sq)] FROM [Data
Sources\Country3.csv] (txt, codepage is 1252, embedded labels, delimiter is ',', msq); ...

5. Reload the script.

6. Click OK to close the Fields tab in the Sheet Properties dialog.
The document has not changed very much. There are, however, a few more countries.

7. Select the country Seychelles.

Seychelles is a country that is listed in Country3.csv, and you can now see that only the list box Area
contains optional data.

8. Create a table box to get a clear picture of the contents of the concatenated table. The box should
contain the fields in the country files (Country, Capital, Area (km.sq), Population(mio), Pop.Growth,
Currency, Inflation, Official name of Country).

9. Use the scroll bar to browse through the data of your table box. You will note that some of the rows are
not complete, but contain a ’Not known’ instead of a value. This is the case for all the countries from the
third country file, containing only a subset of the fields: the values of the missing fields are treated as
NULL.

10. Save the document.

3.5 The table structure
In this lesson you will take a look at the structure of the tables loaded so far. The Table Viewer is a good tool to
keep track of tables and fields in your document, especially when you are working with bigger and more
complex documents. Finally, you will learn how to assign names to the tables while loading them to get a table
structure with suitable table names.

Using the Table viewer
The tables and their associations can be shown graphically in the built-in Table Viewer.
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Do the following:

1. On the File menu, choose Table Viewer.
The Table Viewer shows the three logical tables have been loaded so far:

Country1(concatenation of Country1, Country2 and Country3) is a table listing countries. Each row
contains information concerning a specific country.

CUSTOMER$ is a table that lists customers. Each row contains information concerning a specific
customer. This table is associated to the table above through the field Country, which is found in both
tables.

Transact is a table listing transactions. Each row contains information concerning one sold unit. This
table is associated to the table above through the field Customer ID, which is found in both tables.

The associations made in the example that loads the tables Country1, CUSTOMER$ and Transact.

Associations are shown with lines connecting the associated fields in the respective tables. When a
selection is made in one of the tables, QlikView analyzes how the result of the selection affects the next
logical table. When this table is analyzed, QlikView continues with the next logical table, and so on. The
result of the selection propagates through the chain of tables involved. The tables in the Table Viewer
can be positioned by dragging them with the mouse.

Structures with circular references, when the chain becomes a ring, should usually be
avoided. These are sometimes a sign of an incorrect data model, in which two similar fields
that have slightly different interpretations are treated as one and the same field. If QlikView
discovers the circular reference during the execution of the script, the tables will be set to
loosely coupled. For more information, see the QlikView online help.

2. Click on the header of the table Country1.
All tables directly associated with this table (only one actually) will be highlighted.

3. Click on the field Customer ID in one of the tables where it appears.
The field name will be highlighted in all tables where it appears.
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4. Position the mouse pointer over the field Currency in the Country1 table.
QlikView shows information for this field in a pop-up. The information density is 98 %, which means that
98 % of the records in the Country1 table have a value in this field. The records coming from the file
Country3.csv do not have a value in this field, therefore the density is not 100%. Furthermore it is
indicated that Currency is a text field.

5. Right-click the header of the Transact table and choose Preview.
QlikView displays the first lines of the Transact table. This is a useful feature to get a quick overview over
the content of a table in complex data structures with many tables.

6. Close the table preview and the Table Viewer.

The table view can be copied to the clipboard for inclusion in documentation or printed with the help of
toolbar buttons available.

Labeling tables in the script
When loading data from files, QlikView uses the file names as table names in the document. Data source files do
not always have meaningful, self-explanatory names. In this case you can and should assign adequate table
labels to the tables when loading them in the script. This is done by stating the table label followed by a colon
before the load statement loading the table.

In our document, the tables are called Country1, CUSTOMER$ and Transact. Country1 holds data from three
files and would better be named just Country. CUSTOMER$ is capitalized and holds an unnecessary dollar-sign
that comes from the Excel load. Transact is very general, a more specific name, like Sales, would certainly be
better.

Do the following:

1. Open Edit Script.

2. Position the cursor after the Country1 directory statement and press Enter to add a new line.

3. Type Country:. Do not forget the colon after the table name.
The script looks like this:

... Directory; Country: LOAD Country, Capital, [Area(km.sq)], ...

4. Name the customer table as follows:

... Directory; Customer: LOAD [Customer ID], Customer, Address, ...

5. Name the sales transactions table as follows:

... Directory; Sales: LOAD [Transaction ID], Year, Year as YearForecast, ...

6. Reload the script and close the Fields dialog.

7. Open the Table Viewer.

8. Check that your tables have the names that you assigned to them.

9. Close the Table Viewer and save your document.

You have now labeled tables in the script.
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3.6 Layout themes
Themes are very useful because you only need to create a layout formatting once, then copy it to any new
documents that you create. The basic idea is to “extract” layout settings from an existing QlikView document to
a theme file, and then apply the same settings to the new document.

Creating a theme
You will now create a very basic layout theme containing layout settings for the sheet background and list boxes.
The file Tutorial.qvw that you used in the first part of the Tutorial contains all the layout settings that you need
for your new document: a QlikView swirl in the background of the sheets, gray captions for inactive objects and
green captions for active ones.

Do the following:

1. Open the file Tutorial.qvw. You find it in the folder Working with QlikView (page 11).

2. On the Tools menu, choose Theme Maker Wizard.

3. Make sure that New Theme is selected and click Next >.

4. Name the theme file MyTheme.qvt and save it in the ..\Tutorials source\Creating a Document folder.

5. In the drop-down list Source, select Document.

6. Make sure check box Object Type Specific is selected and click Next >.
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The Theme Maker Wizard

7. Make sure that only the following check boxes are selected:

l Color Map

l Document Background

l Tabrow

l Custom Selection Colors

l Sheet Object Styles

l Tabrow Style

8. Click Next > and then click Finish to save the theme and close the dialog.

You have now created a very basic theme containing the sheet background, sheet object styles and
tabrow settings. Now you want to add green and gray captions for relevant sheet objects to the theme.

Modifying a theme
Still in the Tutorial.qvw, do the following:

1. Open the Theme Maker Wizard again.

2. Click Next > and select Modify Existing Theme, open the theme you have created and click Next >.

3. Under Source, select a list box with the correct caption color. In this case you pick the list box Country.
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Mark the check boxes Object Type Specific and Caption Border. Click Next >.
The layout settings from the list box are now added to the theme.

4. Click Next > until you reach Step 4 - Insertion of properties in theme.

Here you mark check boxes to select what objects the caption and border settings should apply to.

5. Select all objects - except buttons, text objects and line/arrow objects - you might want a different layout
for these.

6. Click Next > and then click Finish to save the theme and close the dialog.

You have now created a theme.

Applying a theme
To apply the settings saved in the layout theme to another document.

Do the following:

1. Open the file MyDocument.qvw that you created in the previous section of the tutorial.

2. On the Settings menu, choose Document Properties, then click on the Layout tab.

3. Click Apply Theme and open your theme MyTheme.qvt.
If you want to apply a theme to a single object, open its properties dialog, go to Layout tab and click
Apply theme.

You can go back and adjust your theme at any time and as often as you like. You may also want to add
layout properties for other sheet objects, such as buttons. For more information, see the QlikView online
help. If you like, you can compare your layout with the layout in the file SampleDocument.qvw that you
find in the Creating a Document folder.

Saving, closing and exiting
If you don’t want to turn to the next lesson right away, you can close the document. You should also save the
document, since the following lessons are based on the work you have done so far.

3.7 Loading additional files
In this lesson, you will learn how to load a tab separated text file without field names. You will also get an
introduction to loading files using the ODBC interface.

Loading a tab separated file without labels
The ..\Tutorials source\Creating a Document\Data Sources directory contains a file with information on the
markets to which the different countries belong. Just like the files you have loaded so far, Markets.tab is a text
file. However, instead of being separated by commas, its field values are tab delimited. Furthermore, the file does
not contain any labels (field names). The loading procedure is similar to the one you have encountered in the
previous lessons.

Do the following:
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1. Start QlikView and open the file MyDocument.

2. Open Edit Script.

3. Position the cursor at the end of the script and press Enter to get an empty line.

4. Choose Table Files and open Markets.tab under ..\Tutorials source\Creating a Document\Data Sources.

In the File Wizard, Delimited is still set as type, but this time Tab is selected as the delimiter. For
QlikView to find relations between the new file and those that have already been loaded, you need to give
the fields appropriate names. Naming the first field Market seems like a good choice. The second one
should be named Country to be associated with the Country fields of the files Country1.csv and
Customer.xlsx. Do the following:

5. Click @1 in the header of the first column . Type Market and press Enter.

6. Click @2 in the header of the second column . Type Country and press Enter.

7. Click Finish.
Your script now looks similar to the one below:

Directory; LOAD @1 as Market, @2 as Country FROM [Data Sources\Markets.tab] (txt, codepage is 1252,
no labels, delimiter is '\t', msq);

The contents of the final parenthesis: the delimiter is not comma (,), but tab (\t), and no
labels appears instead of the usual embedded labels.

8. Reload the script.

9. Move the new field Market to the column of displayed fields, then click OK.

You can now study the sales development for different markets during different years.

Loading a file using OLE DB
Until now you have always loaded files directly into QlikView. If you want to access general databases or files
that are not stored in a format that QlikView can read, you need to use OLE DB or ODBC (Open DataBase
Connectivity).

In this example, we will only create an OLE DB connection. For more information, see the QlikView online help.

QlikView works with both 32-bit and 64-bit ODBC drivers. It is however important to use the correct
versions of the ODBC drivers. The 32-bit version of QlikView will only work with the 32-bit ODBC
drivers. The 64- bit version of QlikView works with 64-bit ODBC drivers by default, but can be set to
use 32-bit ODBC drivers. In this case, use the option Force 32 Bit in the Edit Script dialog.

In the ..\Tutorials source\Creating a Document\Data Sources directory you will find an Access file named
Salesperson.accdb, which contains the names of the salesperson who performed the sales described in the file
Transact.csv. The names of the salesmen are of great importance, so you would like to associate
Salesperson.accdb to the data in your document.
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One possible way of doing this is to export the database table to a character separated text file, that is a file that
QlikView can read by means of a LOAD statement.

It is also possible to load the file using OLE DB, which is what you will do in this example.

Do the following:

1. Open Edit Script and place the cursor at the end of the script.

2. In the Database drop-down select OLE DB and click Connect to establish a connection with the data
source.

3. In the Data Link Properties dialog, make sure that the OLE DB Provider for ODBC Drivers is
selected, then click Next >> to get to the Connection page.

4. Since you are working with a generic data source not yet defined, select Use connection string, then
click Build.

5. In the Select Data Source dialog, choose the Machine Data Source tab.

6. Select MS Access Database, then click OK.

7. In the Login dialog, click Database....

8. In the Select Database dialog, open Salesperson.accdb under ..\Tutorials source\Creating a
Document\Data Sources directory. Once you find the correct location, the Salesperson file should be the
only one available in the list on the left. Select it and close the dialog.

9. Close the remaining dialogs.

Your script now contains a CONNECT statement, connecting you to the selected data source. The
statement looks similar to this:

OLEDB CONNECT TO [Provider=MSDASQL.1;Persist Security Info=False;Extended Properties="DSN=MS
Access Database;DBQ=C:\ProgramData\QlikTech\QlikView Tutorial\ Creating a Document\Data
Sources\Salesperson.mdb; DefaultDir=C:\ProgramData\QlikTech\QlikView Tutorial\ Creating a
Document\Data Sources;DriverId=281;FIL=MS Access;MaxBufferSize=2048;PageTimeout=5;UID=admin;"];
The next step is to select the tables (in this case there is only one, but if you access a database you usually
have a great number of tables to choose from) and fields to load.

Do the following:

10. Click Select....
The Create Select Statement dialog is now opened. The Fields box lists the available fields, whereas
the Database Tables box contains the available tables. At the bottom of the dialog, you get a preview of
the statement (a standard SQL SELECT statement), which will appear in your script as soon as you click
OK. By default, a star is selected in the fields list. The star is equivalent to all fields. You want to load all
fields, but for a better understanding of the script select them to make their names appear in the script:

11. Select Salesperson in the Database Tables list to the left.

12. Click on the field Distributor ID, then press the Shift key and hold it down while clicking Salesperson ID.
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13. Click OK. Your script now looks like the following:

SQL SELECT `Distributor ID`, Salesperson, `Salesperson ID` FROM `C:\ProgramData\QlikTech\QlikView
Tutorial\English\ Creating a Document\Data Sources\Salesperson.accdb`.Salesperson;
The Salesperson table is associated with the existing data through the field Salesperson ID, which it has
in common with Transact.csv.

14. Reload the script.

15. Add the new field Salesperson to the Sales sheet.

16. Make a few selections and study the relations.

17. Clear your selections.

Now you know how to load data from different kinds of files and formats. In the next lesson you will learn
how to link external information to field values using a special kind of load process.

3.8 Linking external information to a document
Besides associating and concatenating tables that contain data, it is also possible to link information to field
values in the data. The links are defined in information tables which must be loaded in a special way. In this
lesson you will link flags to specific values in the Country list box.
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Looking at an info table
Let us start by looking at the file containing the information that we want to link.

Do the following:

1. Open a text editor, for example Notepad, and choose Open from the File menu.

2. In the box Files of type, select All files.

3. Open the file FlagsOECD.csv in the ..\Tutorials source\Creating a Document\Data Sources directory.

Information table defining bmp files that should be linked to countries

It is a two-column table, in which different values of the field Country are associated with different files.
Each value must be put on a separate row. The file associated with a field value will be shown, played,
executed, etc. depending on the file type. Some file types, for example files of the bmp or wav (sounds)
type are handled internally in QlikView. For other file types, the associated program is used to open the
document.

To associate a file type (with no association) with a program, open the Windows Explorer
(Windows 7) or File Explorer (Windows 8.1 and 10). Select a file of the concerned type in the
structure and double-click it. This opens a list of available programs. Pick an appropriate
program, preferably Notepad or Excel, then click OK. All files with this extension will from
now on be opened with the program you selected.

4. Close the editor.

Loading the info table
To load the info table, Do the following:
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1. Open QlikView and open your file MyDocument.qvw

2. Open Edit Script.

3. Position the cursor at the end of the script and press Enter to get an empty row.

4. Click Table Files and open the file FlagsOECD.csv in the ..\Tutorials source\Creating a Document\Data
Sources directory.

5. In the File wizard, Delimited is set as type, Comma as delimiter. Embedded Labels is selected as label.

6. Click Finish.
The statement generated will load the file FlagsOECD.csv as a regular data file. This is not what you want
to do: you would like QlikView to use Flags OECD.csv to link information to specific field values.

Change the script manually
Do the following:

1. Type INFO before the LOAD statement.
As the word INFO is a keyword in the script, it will turn blue. The script will look like this:

Directory; INFO LOAD Country, Flag FROM [Data Sources\FlagsOECD.csv] (txt, codepage is 1252,
embedded labels, delimiter is ',', msq);

2. Reload the script.

3. Close the Field page and save your document.

Viewing the linked information
To view the information you have linked, Do the following:

1. Select Germany from the list of countries.

2. Click on the small info symbol in the upper right corner of the list box.
An independent window containing Germany’s flag now appears in the document.

The relative paths from the QlikView document to the image files must be stated correctly in
the info table for this to work.

3. Close the window.

4. Select France from the list of countries and click the info symbol to make the specified picture appears.

5. Close the flag and clear all selections.

Pictures and multimedia presentations can be shown in the right contexts, other applications can be
started, and specific documents opened. You can link almost any type of file to field values. It is also
possible to simply type words in the second field of the info table instead of specifying a path to a file. In
that case, QlikView will show the text in an internal text viewer.

For more information, see the QlikView online help.
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Embedding external info
In many cases it is good that pictures etc. do not have to be stored inside a QlikView document and take up
space in memory and on disk. If there are not too many pictures and you want to be able to send a QlikView
document without worrying about sending the picture files as well, you can embed the info in the QlikView file.

Do the following:

1. Open Edit Script.

2. Find the statement that starts with Info Load.

3. Type Bundle in front of Info Load.

4. Reload the script and save your document.

The flag pictures are now stored inside the QlikView document itself and do not need to be moved with the
QlikView document.

Displaying info in a text object
Instead of displaying the picture in a separate window that you need to open manually by clicking the info
symbol, you can also display the picture in a text object that is permanently visible and that is updated
automatically according to your selections.

Switch to the Tutorial.qvw file. Do the following:

1. Go to the Geography sheet.

2. Select Canada in the list box Country and click Create Text Object in the design toolbar.

3. In the Text edit box enter ='qmem://Country/'&only(Country).
This syntax is a reference to the pictures. The equal sign indicates that the text is an expression. qmem
stands for a reference to an internal file, that is a file stored in the QlikView document. Country is the
name of the field to which the pictures are related. only(Country) is an expression returning the value
currently selected in the field Country.
The expression is evaluated each time the logical state in the field Country changes. For example, when
you select Italy in the list box Country, the expression evaluates to qmem://Country/Italy. This is the
place where the file is stored in the document.

4. In the drop-down Representation, select Image.

5. In the drop-down Image Stretch, select Keep Aspect.

6. Under Background set the Transparency to 100%.

7. Close the dialog.
Now your sheet shows a text object displaying the Canadian flag.

8. Move and size the text object so that the content is entirely visible.

9. Try another selection in the field Country and check the text object.

You have now displayed a picture in a text object that is permanently visible and that is updated
automatically according to the selections you have made.
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Saving, closing and exiting
If you don’t want to turn to the next lesson right away, you can close the document. You should also save the
document, since the following lessons are based on the work you have done so far.

What is next?
You have now finished this part of the tutorial. In addition to the basic knowledge about selections, sheets and
sheet objects acquired in the first part (Working with QlikView (page 11)), you have learned how different kinds of
files are loaded into the associative QlikView database and how the logical structure is created.

Qlik Education provides a wide array of course content and delivery options for different user roles and product
applications. Visit http://www.qlik.com/training for a complete course catalog.

The final part of this tutorial, Advanced features (page 117), lets you further explore the possibilities of QlikView.
The lessons in the final part are especially suitable for application developers, because they deepen the
knowledge about loading data and building the data structure. It differs from the first two parts in that it
contains independent lessons (that is the procedures performed are not based on the work done in previous
lessons), thereby allowing you to immediately go to the lesson that interests you the most.
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4 Advanced features
l More about associations

l Load inline

l Field groups and cyclic display in charts

l Cross tables

l And-mode

l Number formats

l Security

4.1 Introduction
This final part of the Tutorial deepens the knowledge you have already acquired and lets you further explore the
possibilities of QlikView. Among other things, you will learn how to modify the script to load different types of
table formats in an optimal way and how to use access restriction. Moreover, Advanced Features provides a
lesson on the interpretation and formatting of numbers.

Although most of the functions presented are related to the script, we have also devoted a chapter to advanced
layout features: you will learn to create hierarchic and cyclic field groups and to use cyclic expressions in charts.

The lessons in this third part of the Tutorial, Advanced Features, are independent (the procedures performed are
not based on the work done in previous lessons), which allows you to immediately go to the lesson that interests
you the most.

The files used in this part are found here ..\Tutorials source\Advanced.

4.2 More about associations
The Fields dialog appears after every script execution contains a check box named Show System Fields. If this
check box is selected, the column listing available fields includes six fields preceded by a dollar sign ($). These
fields, called system fields, are very useful for obtaining an overview of the logical structure of a QlikView
document.

The first section of this lesson describes the system fields and shows how they can be used on a system sheet. The
second part shows an example of how you can solve a common problem using the system fields: display of
frequency information for key fields.

Creating a system sheet
Do the following:

1. Start QlikView.

2. Open the file Advanced.qvw found in the Advanced folder.

3. Choose Add Sheet from the Layout menu.
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4. Go to the Sheet Properties dialog. Name the sheet System.

5. Go to the Fields tab.

6. Make sure the option Show System Fields is selected.

7. Move the system fields (the ones preceded by a dollar sign, $) to the column Fields Displayed in List
boxes

8. Click OK.

9. Size the list boxes until you see all field names and all field values, then rearrange the boxes.

10. Save the file as System.qvw.

The system fields show:

l the names of the fields retrieved ($Field),

l the names of the tables loaded ($Table),

l the number of rows and columns in a table ($Rows and $Fields),

l the column number for a specific field ($FieldNo),

l the names of the info tables loaded ($Info).

Using the system sheet
Your system sheet is now ready, but to further improve it, choose frequency display for the list box $Field.

Do the following:

1. Open the Properties dialog for the list box $Field.

2. On the General tab, select the check box Show Frequency.

3. Go to the Sort tab and select Frequency, Descending.

4. Click OK.
The values in the field $Field are now followed by numbers indicating their number of occurrences in the
tables. The list box is being sorted by frequency and the field with the greatest number of occurrences is
placed at the top. You see that the field Country occurs in three tables Customer ID and Salesperson
ID in two tables, and all the other fields are in only one table.

5. Open the Table Viewer to have a closer look at the structure.
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The three fields appearing more than once are the fields used to associate the tables of the document.

6. Click OK to go back to your document. Close the Table Viewer.

7. Click Country in the $Field box.
The program now shows that the field Country occurs in the tables Country (a logical table consisting
of three concatenated country tables), Customer and Market. The other list boxes provide additional
information on the number of rows and fields of the concerned tables, and on the column numbers of
the field in the respective tables. Moreover, the list box $Info on the system sheet shows the info table
associated with the field Country.

As soon as only one table or info table is possible (selected or optional) in a list box, a small info symbol
is displayed in the top right-hand corner of the list box. Clicking this will allow you to edit the table

directly.

Edit table
Do the following:

1. Click Customer in the list box $Table.

2. The info symbol appears in the top right-hand corner. Click it.

3. The original table is now opened by the associated program. Study it, then close the program to get back
to QlikView.

4. Clear your selections.

If the file type of the table is not associated with an appropriate editor, the table will not be
opened. To associate a file type with a program, open Windows Explorer (Windows 7) or File
Explorer (Windows 8.1 and 10). Select a file of the relevant type in the structure and double-
click it. This opens a list of available programs. Pick an appropriate program, preferably
Notepad or Excel, then click OK. (Another option is to choose View, Folder Options from
the Explorer menu and go to the File Types tab.)

When working with large sets of data with complicated structures, it is impossible to keep the entire data
structure in mind. This is when the system sheet is of crucial importance.
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Creating a system table
Besides displaying the system fields in list boxes, you can also illustrate the relations by creating a system table.
Do the following:

1. From the System sheet, open the New Sheet Object menu.

2. Select System Table.
The system table now appears on your system sheet, size and study it. You will find that the first column,
listing all the fields found in the document, is followed by one column for each loaded table. If a table
contains the field listed in the leftmost column, the field also occurs in the table column; if not, a -
(indicating a NULL value) is displayed. You can easily see which of the fields are keys, common to more
than one table. The system table thus clearly shows how the tables of the document are associated. It can
be a useful complement to the Table Viewer described in The table structure (page 104).
Below you find one of many examples of situations where the use of system fields is indispensable.

Showing frequency in key fields
Suppose you work with the Customers sheet and want to see how many customers you have in different
countries, that is how many times the countries occur in the data.

Do the following:

1. Go to the Customers sheet of your document.

2. Right-click on the list box Country, then click Properties.

3. Go to the General tab.
The check box Show Frequency is disabled, it is not possible to show frequency for this field.
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By studying the System sheet, you clearly see that the field Country occurs in more than one table. As a
matter of fact, three of the loaded tables contain a field named Country. As the three Country fields are
treated as one due to the associations, it is impossible for the program to know which of the tables it
should use for calculating data frequencies. Since making guesses could lead to erroneous results,
QlikView has been designed not to allow certain operations when the data interpretation is ambiguous
for key fields. Country and Market, containing geographical information and a list of the markets to
which different countries belong, list each country only once. The Customer table, however, contains
more than one occurrence of countries in which several customers reside. This is what we are interested
in. To obtain the information you need, load the field Country a second time under a new name from
the table Customer.xlsx:

4. Close the List Box Properties dialog.

5. Open the Edit Script dialog.

6. Find the statement loading Customer.xlsx and position the cursor after the last field (Country), then type
Country as CustomerCountry. The LOAD statement now looks like this:

Directory; Customer: LOAD [Customer ID], Customer, Address, City, Zip, Country, Country as
CustomerCountry FROM [..\Creating a Document\Data Sources\Customer.xlsx] ooxml, embedded labels,
table is CUSTOMER$);
You need to keep the field Country. If you do not, there will be no key field and no association with
previously loaded tables.

7. Click Reload.

8. Move the new field CustomerCountry to the list of displayed fields, then click OK.

The list box CustomerCountry contains only countries in which there are customers. It holds less values
than the Country list box. This can easily be seen in the status bar, which you find in the right lower
corner.

9. Select all countries beginning with B in the list box CustomerCountry.

See the information about the list box CustomerCountry in the QlikView status bar at the
bottom of the window.

Besides a time stamp of the last reload of the document, the status bar holds information about the
active list box field. Behind the D, the number of selected values in relation to the number of distinct
values in the list box. This means there is a selection of 9 out of 94 distinct values in the field
CustomerCountry. Behind the F, the number of selected records in relation to the total number of
values. The selected countries occur in 13 out of 181 records, that is there are 13 customers in the selected
countries and there are 181 records in total in the Customer table. This can be verified on the system
sheet.

10. Click the header of the list box Country to activate this object.
Again look at the information in the QlikView status bar. There are 9 values selected out of 197. This
means the Country field holds 197 distinct values in total. There is no information about the number of
records as Country is a key field and frequency is not available. For CustomerCountry it is possible to
show frequency information.
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11. Clear the selection.

12. Click on the CustomerCountry list box with the right mouse button, then choose Properties.

13. On the General tab, select the check box Show Frequency.

14. Go to the Sort tab and select Frequency.

15. Click OK.
The countries are now displayed in frequency order.

You may have to size the list box to see the numbers. Since it actually makes more sense to have the
CustomerCountry field on this sheet than the Country field, Do the following:

1. Remove the Country list box.
When selecting countries on the Customers sheet, there will now always be at least one customer
optional.

2. Adjust the layout.

3. Save the file.

Key fields have yet two limitations besides the inability to show frequency:

l Statistics boxes based on a key field show n/a for most statistical entities.

l In charts it is not possible to create expressions containing functions that depend on frequency
information for key fields (for example sum, count functions, average) unless the distinct modifier is
turned on.

If you wish, compare it with the file SystemFinal.qvw found in the Advanced folder. For more information, see
the QlikView online help.

4.3 Load inline
In some cases, you may want to add data by entering it directly in QlikView rather than loading it from a file or a
database. In this lesson you will learn how to do this with load inline. Load inline can be used for adding data
in existing tables or for reading new tables into the document.

Adding a record with load inline
Do the following:

1. Start QlikView and open the file Inline.qvw found in the ..\Tutorials source\Advanced directory.
The document holds two tables, Customers and Sales. Suppose you want to add a customer to the
document, but without changing the original files.

2. Open the Edit Script dialog.

3. Position the cursor behind the load statement that loads the Customer.xlsx file.

4. Type the following lines:

Load * Inline [ Customer ID,Customer, Address, City, Zip, Country 1181, Alexander's Catering Service,
Fisherman's Drive 4, Portsmouth, BH 354 RW, Great Britain];
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l The first line (Customer ID,Customer, Address, City, Zip, Country) lists the field names of
Customer.xlsx (the table to which you want to add the record).

l The second line (1181, Alexander's Catering Service, Fisherman's Drive 4, Portsmouth, BH 354 RW,
Great Britain) contains the record that is to be added.

l The star symbol * is equivalent to "all fields", which means that the statement should load all of
the fields of the new record.

Due to limited space, the record in the above example does not fit in one line. When
reproducing this inline clause in the script, it is important that you put the entire record in
one single line: Portsmouth etc. should thus follow directly after Fisherman’s Drive 4.

5. Click Reload.

6. Click OK to close the dialog.

7. No new fields has been added, but there are new field values in some of the list boxes. Click Alexander’s
Catering Service in the Customer list and check that the record has been read properly.
The data enclosed by the parenthesis after inline is treated like an ordinary table. Having the same set of
fields as the customer table, the inline table has been concatenated with the customer table. You can
easily check this by studying the System sheet: only two tables are displayed in the $Table list box (the
concatenated table is always given the name of the first table read, which, in this case, is Customer).

8. Save the document as MyInline.qvw, or something similar.

Naturally, inline tables can be used for other purposes than for adding records to existing tables. If, for
instance, you wish to load very small tables, it may be easier to create these directly in the script than to
create and load an external file.

Adding a table with load inline
The document MyInline.qvw contains a field with the months of the year written as numbers. Suppose you want
to create a chart with the names of the months spelled out, and another chart showing sales per quarter. This is
easily solved with a new table containing this information. Adding a new table means associating new
information to already existing information using a field name. Typical examples could be connecting an
account number to an account name or splitting a date into three fields for year, month and day, respectively.

In this example, you will use load inline to add month numbers and quarters. As there is a little more data to
add this time we will use the built-in inline wizard to create the load inline statement, usually a much more
convenient method than typing directly in the script.

Do the following:

1. Open the Edit Script dialog.

2. Position the cursor at the end of the script.

3. Open the Inline Data Wizard from the Insert menu, Load Statement, Load Inline.
The dialog that opens looks like a small spreadsheet and in fact works much like one.
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There is no support for formulas in the data cells.

4. The cursor will be positioned in the top left data cell. Enter the data into the Inline Data Wizard, as
shown in the picture below. Use Enter or the arrow keys to move between cells and fill in the table as
shown below.

5. Finally double-click in the header row over 1 and enter the field name Month. Repeat for the remaining
columns as shown below.

If you already have the table stored in a program such as Excel it can of course be pasted
into the QlikView inline wizard.

6. Click OK. You now have a piece of script looking like this:

LOAD * INLINE [ Month, Month Name, Quarter 1, January, 1 2, February, 1 3, March, 1 4, April, 2 5, May, 2 6,
June, 2 7, July, 3 8, August, 3 9, September, 3 10, October, 4 11, November, 4 12, December, 4];

7. Click Reload.
Two new fields have been added to the list of available fields, Month Name and Quarter. The inline table
has been associated with the Sales table by the field Month.

8. Click OK.

Create a bar chart
Do the following:
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1. Create a bar chart showing sales per quarter (choose Quarter as dimension and add the expression Sum
of Sales). In case you need help,

see Changing chart types using a fast type change (page 42).

The potential appearance of your inline document.

If you wish, compare your file with the file InlineFinal.qvw.

2. Save the document, then close it.

4.4 Field groups and cyclic display
Instead of displaying single fields as dimensions in charts, it is possible to define groups of fields to be used for
this purpose. Working with field groups allows you to display data in a very efficient way, since the resulting
charts will show the selected fields in a hierarchical (drill-down) or cyclic sequence. In this lesson, these
important features will be explained: you will define both hierarchic and cyclic field groups and create
corresponding charts.

The use of field groups should not be confused with cyclic display in charts. Cyclic display, constituting the last
part of this lesson, can be applied to any chart having more than one expression, and results in the expressions
being displayed sequentially. Just like the use of field groups, however, it saves space and allows you to make
quick changes in the data displayed in the chart.
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Field groups
One main difference between QlikView and many other database viewers, OLAP tools. is that in QlikView there is
no need to predefine any hierarchies in the data. The unique associative logic of QlikView gives you the complete
freedom to access any field as a full dimension in any order you like.

For most purposes this freedom is extremely powerful. There are occasions when a hierarchy could actually help
you to display data more efficiently. QlikView therefore offers the possibility to define groups of fields. The
groups can be hierarchic (drill-down) or non-hierarchic (cyclic).

Creating a drill-down group
When several fields form a natural hierarchy, it makes sense to create a drilldown group. Do the following:

1. Start QlikView, then open the file Groups.qvw found in the ..\Tutorials source\Advanced directory.

2. In the Settings menu choose Document Properties and go to the Groups tab.

3. Click the New. The Group Settings dialog opens.

4. In the Group Name box change the default name to Time.

5. Select Year, Quarter and Month in the list of available fields by Ctrl-clicking them, then click Add to
move them to the column of used fields. You can also double-click them to move them.

6. Use the Promote and Demote buttons to get the correct hierarchy:Year, Quarter and Month. This is of
great importance, since the order of the fields in the group corresponds to the display order in charts.

7. Click OK twice to close all dialogs.

You have now created a drill-down group, which you can use as a dimension in a chart.

Creating a cyclic group
Sometimes it may be useful to group fields which do not form a natural hierarchy or do not have anything in
common at all. The reason would be to make quick changes of the data displayed in a chart and to save space.

Any fields can be grouped together in a cyclic group.Do the following:

1. In the Settings menu choose Document Properties and go to the Groups tab.

2. Click the New button. The Group Settings dialog opens.

3. In the Group Name box change the default name to Cyclic.

4. Select the Cyclic Group option.

5. Double-click Country, Salesperson and Year in the list of available fields to move them to the column of
used fields. The order of the fields in the list is of no importance when defining cyclic groups.

6. Click OK twice.

You have now created a cyclic group. When used as a dimension in a chart, it will allow you to switch
between the fields of the group (x-axis) while keeping the same expression (y-axis).
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Creating and using a cyclic bar chart
To create a cyclic chart, Do the following:

1. Click the Create chart button on the toolbar.

2. Type Cyclic as window title, then click Next > to go to the Dimensions tab.
The Cyclic group is listed among the ordinary field names. Just like the drill-down group, it is preceded

by a symbol. For cyclic groups, this symbol is a circular arrow.

3. Double-click the Cyclic group to move it to the column of Used Dimensions.

4. Click Next >.

5. The Edit Expression dialog automatically opens. Compose the expression Sum of Sales, then click
Paste. Alternatively, you can type the expression directly in the edit field. Click OK.

6. Type Sales in the Label box.

7. Click Next >. On the Sort tab, select the values by Y-value, Descending, and click Finish.

8. Right-click the chart and select Properties.

9. On the Colors tab, mark the check box Multicolored.

10. Click on the Number tab, highlight the expression and select Integer and type 1000$ in the Thousand
Symbol box, then click OK.

Initially, your chart shows the sum of sales per Country, which is the first field in the field list.

11. Right-click the cyclic chart and choose Properties.

12. On the Dimension Limits tab, mark the check box Restrict which values are displayed using the
first expression and select the radio button Show only>.

13. Select Largest from the drop-down list and enter the number 10>.

14. Switch to the next field by clicking the cycle icon in the bottom right-hand corner of the chart.
Now Salesperson, the second field, is displayed.

15. If you click the icon a second time, the sum of sales per year will be shown. Year is the third and last field
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of the field group.
When the last field in the list has been used, the turn goes back to the first field. The chart can be cycled
indefinitely. It is also possible to right-click on the cycle icon, in which case a list of the fields in the cyclic
group is displayed for direct selection.

16. Minimize the chart.

Showing three charts in one frame in this way is a very efficient way of displaying data. It also allows you
to make quick changes of graphically displayed data.

Cyclic display of expressions
The Expressions tab in the Chart Properties dialog provides a possibility to group several expressions
together. Grouped expressions are displayed sequentially instead of simultaneously. The switching between
expressions is done using a button similar to the one used in cyclic charts.

To create a bar chart with cyclic display of expressions, Do the following:

1. Click the Create chart button on the toolbar.

2. Choose Cyclic Display as window title, then click Next > to go to the Dimensions tab.

3. Move the field Year to the column of Used dimensions, then click Next >.
The Edit Expression dialog automatically opens.

4. Compose the expression Sum (Sales), then click Paste and the OK to close the dialog.

5. Type Sum of Sales in the Label box.

The Group button is disabled: you need two expressions in the chart to be able to use it.

6. Click Add to add a second expression.
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7. This time, create the expression Count (DISTINCT [Transaction ID]). To do so choose the aggregation
Total count, Field and Transaction ID. Check the Distinct option to make sure that several
occurrences of the same transaction are only counted once. Click Paste.

8. Then click OK to close the dialog.

9. Type Count of Sales in the Label box.

10. The Group button is now enabled: click it.

11. Click Next > until you reach the Colors tab. Mark the check box Multicolored. Click Next >.

12. On the Number tab, highlight the expression Sum of Sales and select Integer and set 1000$ as
Thousand Symbol (for the first expression), then click Finish.
The chart looks like an ordinary bar chart showing the sum of sales per year. The cycle icon in the
bottom left-hand corner indicates that the chart has further potential.

13. Click the cycle icon.
The chart now turns to showing the number (total count) of sales performed during different years:

Naturally, you can choose to display more than two expressions this way. It is also possible to combine
groups and cyclic display into powerful multi-dimensional charts.

14. Save the document using a name of your choice. If you wish, compare it with the file GroupsFinal.qvw.

15. Close the file.

4.5 Loading cross tables
A cross table is a common type of table featuring a matrix of values between two orthogonal lists of header
data. By using the QlikView cross table statement, you can load this type of table in a very elegant way. The
procedure is described in this lesson.

Loading a cross table
You will start by looking at a crosstable in Excel (or a similar program). Do the following:
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1. Open the Explorer, then find the file Crosstable1.csv in the ..\Tutorials source\Advanced\Data Sources
directory and double-click it.
Excel opens the file. This table holds the number of orders per month, the content appears as follows.

2. Close the file.

Loading the table into QlikView
1. Start QlikView and choose New from the File menu. Name the document Crosstable1.qvw and save it in

the Advanced folder.

2. Open the Edit Script dialog.

3. Click Table Files and browse for the file Crosstable1.csv in Advanced . Click Open.

4. If the file wizard has made a correct interpretation, click Finish.
The following statement has been generated in your script:

Load Year, Jan, Feb, Mar, Apr, May, Jun FROM [Data Sources\Crosstable1.csv] (txt, codepage is 1252,
embedded labels, delimiter is ',', msq);

5. Load the script by clicking Reload.

6. In the dialog Sheet Properties that now opens, add all the fields except the system fields to the Fields
Displayed in List boxes.

7. Click OK.
The following list boxes appear on your screen:

The result is of this load process is one field for Year and one field for each of the months. This is not
what you want: you would prefer to have three fields generated, one for each header category (Year and
Month) and one for the data values inside the matrix.

2. Open the Edit Script dialog box again.

3. Now add the crosstable prefix, indicating that the table is to be loaded as a cross table, to your LOAD
statement. The crosstable prefix should be followed by a parenthesis containing the names you wish to
apply to the new fields, in our case Month and Orders:

Crosstable(Month,Orders) LOAD Year, Jan, Feb, Mar, Apr, May, Jun FROM [Data Sources\Crosstable1.csv]
(txt, codepage is 1252, embedded labels, delimiter is ',', msq);

4. Click Reload. The Fields dialog tab of the Sheet Properties dialog opens. Move the fields Month and
Orders to the column of displayed fields (the field Year is already there), then click OK.
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The following list boxes appear on your screen:

This distribution of values makes a lot more sense.

5. Remove the obsolete (now empty) list boxes for the single months.

6. Save the document, then close it.

Loading a cross table with more than one regular column
The cross table is often preceded by a number of regular columns that should be loaded in a straightforward
way. This is the case in the following table Crosstable2.csv:

In this table the matrix columns are preceded by two regular columns: Salesperson and Year. You would
probably like QlikView to show the contents of the table in four fields.

l Salesperson, containing the values of the first (regular) column

l Year, containing the values of the second (regular) column

l Month, containing the headers of the remaining columns

l Sales, containing the values of the remaining columns

To obtain this result, Do the following:

1. Choose New from the File menu.

2. Name the document Crosstable2.qvw and save it in the Advanced folder. Open the Edit Script dialog.

3. Click Table Files and browse for the file Crosstable2.csv in the Advanced/Data source folder .

4. Click Open. The File Wizard opens. We will use this wizard to create the crosstable statement.

5. Click Next >until you get to the File Wizard: Options page.

6. Click the Crosstable button.
The CrossTable wizard opens.

7. Under Qualifier Fields, set the number of qualifier fields that precede the table to be transformed to 2.
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8. Under Attribute Field, enter the name of the new field that will contain the month names. Type Month.

9. Under Data Field, that is the field that combines the sales figures, type Sales.

10. Click OK. In the preview pane you can now see the transformed table.

11. Click Finish. The generated script statement looks as follows:

CROSSTABLE(Month, Sales, 2) LOAD Salesperson, Year, Jan, Feb, Mar, Apr, May, Jun FROM Data
Sources\Crosstable2.csv (txt, codepage is 1252, embedded labels, delimiter is ',', msq);

The crosstable prefix has the number 2 as a third parameter. This indicates the number of
regular columns in the original table. If no parameter is stated, 1 is assumed.

12. Load the script by clicking Reload.

13. The Fields tab of the Sheet Properties dialog opens. Move all fields, except system fields, to the column
of displayed fields, then click OK.
The list boxes Salesperson, Year, Month and Orders appears on your screen.

14. Save the document, then close it.

For more information, see the QlikView online help.
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4.6 And-mode in a list box
Two selections in different list boxes are always interpreted as logical and, for example QlikView will show all the
field values associated with both the selections. A multiple selection within a list box is however usually
interpreted as logical or, for example QlikView will show data entries associated with any of the selected values.

Under some circumstances, a multiple selection within a list box can be set to logical and, which means that
QlikView will show only data entries associated with all of the selected values.

This lesson features a list box set to and-mode, which you will use for regular selections as well as for not-
selections. You will also learn under which circumstances a list box can be set to and-mode.

Making an and-selection
In the file And.qvw in the ..\Tutorials source\Advanced folder, there is a list box for which the and-mode can be
activated.

Do the following:

1. Start QlikView.

2. Open the file And.qvw in the ..\Tutorials source\Advanced folder.

3. Choose the tab Geography, and find the list box Membership.
This is a list of organizations and geographical areas that the different countries belong to. A country
can be a member of several organizations, and an organization can have many members. There is a
many-to-many relationship between the field Country and the field Membership. Moreover, the field
Membership does not link directly to any other field but Country. Under such circumstances, the field
Membership can be set to and mode. A multiple selection in the Membership field will then be
interpreted as "show only countries that are members of all the selected organizations".

4. Right-click on the list box Membership, then choose Properties.

5. On the General tab mark the check box And mode, then choose the OK button.
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6. Select Europe by clicking it.
The Europe cell should now be green, and have an ampersand & to the left. The organizations shown as
alternatives (white) are the ones that have one or several members of Europe. The organizations that are
excluded are the ones with no members on the European continent.

7. Select G8 by Ctrl-clicking.
You have now selected Europe and G8, that is countries that are members of both. Only five countries
remain optional, and these are all European countries in the G8 group.

Making a not selection
It is also possible to exclude countries in a similar way. Do the following:

1. Deselect G8 by Ctrl-clicking.

2. Select G8 by Ctrl-clicking it, keeping the mouse button down. Release the button when the cell has turned
red.
You have now selected Europe and not G8. Only European countries not in the G8 group are now
optional. This type of selection is called forced exclusion, and is very useful in many-to-many
relationships.
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3. Close the file.

Characteristics of the and table
l Not every field can be set to logical and mode. The and mode is only possible if the field corresponds to

the second column of a two-column table.

l The field must not be fetched from more than one table, the reason being that the and alternative is
logically meaningful only if the concerned field is associated to only one other field.

l There must be no duplicate records in the table. Therefore this kind of table is always loaded using the
distinct predicate. For more information, see the QlikView online help.

If the field is loaded this way, the And mode control in the List Box Properties dialog will no longer be
dimmed and the logical mode of the list box can be changed.
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4.7 Number formats
QlikView can handle text strings, numbers, dates, times, time stamps and currencies correctly. They can be
sorted, displayed in a number of different formats and they can be used in calculations. This means that dates,
times and time stamps can be added to or subtracted from each other.

This lesson deals with the basics of number interpretation and number formatting. The examples have been
designed for computers with regional options set to English (United States). If you are using a computer with
different regional options, number formats in the data sources, in the QlikView script and in the QlikView layout
may look different.
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Handling of numeric data
The issue of obtaining correct number formats is really a question of two different things:

l Interpretation of data when it is loaded.

l Display of different number-based data types.

Data storage inside QlikView
To understand data interpretation and number formatting in QlikView, it is necessary to know how data is
stored internally by the program. All of the data loaded into QlikView is stored in two representations, as a string
and as a number.

l The string representation is always available and is what is shown in the list boxes and the other sheet
objects. Formatting of data in list boxes (number format) only affects the string representation.

l The number representation is only available when the data can be interpreted as a valid number. The
number representation is used for all numeric calculations and for numeric sorting.

If several data items read into one field have the same number representation, they will all be treated as the
same value and will all share the first string representation encountered. Example, the numbers 1.0, 1 and 1.000
read in that order will all have the number representation 1 and the initial string representation 1.0.

Data storage inside QlikView
To understand data interpretation and number formatting in QlikView, it is necessary to know how data is
stored internally by the program. All of the data loaded into QlikView is stored in two representations, as a string
and as a number.

l The string representation is always available and is what is shown in the list boxes and the other sheet
objects. Formatting of data in list boxes (number format) only affects the string representation.

l The number representation is only available when the data can be interpreted as a valid number. The
number representation is used for all numeric calculations and for numeric sorting.

If several data items read into one field have the same number representation, they will all be treated as the
same value and will all share the first string representation encountered. Example, the numbers 1.0, 1 and 1.000
read in that order will all have the number representation 1 and the initial string representation 1.0.

Loading data with default formats
QlikView tries to interpret input data as a number, date, time etc. As long as the system default settings (found in
the Control Panel underClock, Language, and Region in Windows) are used in the data and the number
interpretation variables in the script are correctly defined, the interpretation and the display formatting are
handled automatically by QlikView, and the user does not need to alter the script or any setting in QlikView.

Do the following:

1. Open the Explorer and open the file Date1.csv in the ..\Tutorials source\Advanced\Data Sources folder.

2. Excel opens the file. It consists of three fields, Date, Customer and Sales.
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The dates in the Date field are formatted according to the American standard format
M/D/YYYY (M=month, D=day, YYYY=the year), and that the numbers in the Sales field have
comma as a thousands separator.

3. Close the file.

4. Create a New document in QlikView. Save the document in the Advanced folder and name it
Number.qvw.

5. Open the Edit Script dialog.
A certain number of set statements, defining separators and number formats using the number
interpretation variables, have been generated automatically:

SET ThousandSep=','; SET DecimalSep='.'; SET MoneyThousandSep=','; SET MoneyDecimalSep='.'; SET
MoneyFormat='$#,##0.00;($#,##0.00)'; SET TimeFormat='h:mm:ss TT'; SET DateFormat='M/D/YYYY'; SET
TimestampFormat='M/D/YYYY h:mm:ss[.fff] TT'; SET MonthNames='Jan;Feb;Mar;Apr;May;Jun;Jul;...'; SET
DayNames='Mon;Tue;Wed;Thu;Fri;Sat;Sun';
These settings are taken from the regional settings in your computer on which the script is generated and
could therefore look somewhat different on your computer. The number interpretation variables ensure
a correct re execution of the QlikView script also on computers with other regional settings, provided that
the data files remain the same.

6. Open the Control panel (Start menu, Settings) and go to Regional Settings.

7. Look through the tabs of the Regional Settings dialog, especially Number and Date, and note that the
settings correspond to those defined by the variables above. To get the same results as this example,
English (United States) must be chosen on the first tab.

8. Close the Control panel.

The number interpretation variables may be deleted, edited or duplicated freely. If changed, they
substitute the operating system defaults.

The thousands separator and the date format defined by the number interpretation variables also
correspond to the formats used in the file Date1.csv. QlikView will thus interpret everything correctly.

Do the following:

1. Go back to QlikView and click Table Files in the Edit Script dialog.

2. Find the file Date1.csv in the ..\Tutorials source\Advanced\Data Sources folder then click Open.

3. Make sure that the file wizard has made a correct interpretation of the contents, click Finish.

4. Reload the script.

5. Move the fields Date, Customer and Sales to the column of displayed fields, then click OK.

6. The three list boxes appear on your sheet. Move and size them.
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There is an easy way to find out if QlikView has interpreted the contents as valid numbers: valid numbers
are always right-aligned in the list box, whereas values interpreted merely as text strings are left-aligned.
The contents of both Sales and Date being right-aligned, you can conclude that they have been correctly
interpreted.

Once QlikView has interpreted the data as valid numbers, you can apply other formats using the
Number tab in the List Box Properties dialog. Formatting will be treated in the section Formatting of
data (page 140).

7. Save the document and close it.

Loading data with different formats
Suppose that the values of the field Date have the British date format (DD/ MM/YYYY) instead of the American,
that is a format that differs from the system settings and the formats set at the beginning of the script:

1. Create a newQlikView document. Save the document in the Advanced folder and name it Number2.qvw.

2. Open the Edit Script dialog, then click Table Files.

3. Find the file Date2.csv in the ..\Tutorials source\Advanced\Data Sources folder then click Open.

4. If the file wizard has made a correct interpretation of the contents, click Finish.

5. Click Reload.

6. Move the fields Customer, Date and Sales to the column of displayed fields, click OK.

7. Move and size the three list boxes that appear on your sheet.
This time, the number interpretation has not worked properly. The first two digits in Date have been
interpreted as month although they represent the day. Therefore, dates with a day number greater than
12 have not been recognized as valid dates (these are left-aligned) and in the other values, month and
day have been inverted.

As long as a date is not recognized as numeric, you will not be able to change the number format of the field,
nor make calculations based on the field.

The problem can be solved in one of the following ways:

l By changing the system settings in the Control panel.

l By changing the date format setting in the script.

l By using an interpretation function in the script.

Changing the system settings is usually not a good idea, unless most of the files you load have a type of regional
settings that is different from yours.

Changing the date format in the script
Changing the date format setting in the script is a better solution (moreover, it is very useful if you want a person
with different system settings to use the document). Do the following:

1. Open the Edit Script dialog of your file Number2.qvw. Change the date format setting to DD/MM/YYYY.
The set statements are now the following:
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SET ThousandSep=','; SET DecimalSep='.'; SET MoneyThousandSep=','; SET MoneyDecimalSep='.'; SET
MoneyFormat='$#,##0.00;($#,##0.00)'; SET TimeFormat='h:mm:ss TT'; SET DateFormat='DD/MM/YYYY';
SET TimestampFormat='M/D/YYYY h:mm:ss[.fff] TT'; SET MonthNames='Jan;Feb;Mar;Apr;May;Jun;Jul;...';
SET DayNames='Mon;Tue;Wed;Thu;Fri;Sat;Sun';
Due to this change, dates in the format DD/MM/YYYY should be interpreted properly. Values in the format
M/D/YYYY however are no longer recognized.

2. Re execute the script by clicking Reload.

3. Click OK to close the dialog, then study your document and note that the values in the list box Date are
now right-aligned. They have thus all been interpreted as valid dates.

4. Save the document and close it.

Formatting of data
Once QlikView has interpreted data as valid numbers, they are assigned a default number format which you can
see and modify in the Document Properties dialog on the Number tab.

It is however also possible to choose a different number format in the properties dialog for the sheet object. Do
the following:

1. Click on the list box Date with the right mouse button, then choose Properties.

2. Go to the Number tab.

3. Select Override Document Settings to set a separate number format for the list box.

4. Change the format to Date by marking the check box.

5. In the Format box, the default date format of the operating system appears. It can be changed to any
other format of your choice. For instance, you may prefer the standard ISO format YYYY-MM-DD. Erase
the contents of the Format Patter box and enter the new format, or click the ISO button.

6. Click OK.
The specified format has been applied to the values of the list box Date. To choose another date format,
simply open the Number tab of the properties dialog again and change the contents of the Format box.

If the field originally contained differently formatted values, for example certain dates with the format
M/D/YY and others with the format DD/MM/YY, you may want to return to the original formatting. For
ordinary text files, however, this is only possible if the script is re-executed with the Survive Reload
check box (Document Properties dialog, Number tab) deselected.

The Default from Input button on the Number tab is only available for fields with a defined
data type read from a database using ODBC.

7. Save and close the document.

It is also possible to set the formatting by using formatting functions in the script. For more information, see the
QlikView online help.
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4.8 - Security
It is important that information is distributed only to those who have rights to see it. Since QlikView makes the
previously cumbersome process of retrieving information a very simple task, it is obvious that security is an
issue.

A security mechanism in QlikView can be set up in two different ways:

l Built into the QlikView document script.

l Set up through the use of QlikView Publisher.

If the QlikView Publisher is set up to handle security, then each QlikView file will be split up into several files, each
containing the data pertaining to the relevant user or user group. These files will be stored in folders with the
correct OS security settings, that is QlikView lets the operating system handle the access. There is, however, no
security built into the file itself, so there is no protection on a downloaded file.

As we cannot assume that you are working with QlikView Server and Publisher, this lesson, which is the last
lesson of the tutorial, refers to the second possibility: security settings that are built in the script of the document.
In this case one single file can be made to hold the data for a number of users or user groups. QlikView will use
the information in the script to grant or refuse access.

Sections in the script
Access control is managed by one or several security tables loaded in the same way as QlikView normally loads
data. It is thus possible to store these tables in a normal database.

The script statements managing the security tables are given within the access section, which in the script is
initiated by the statement section access. If an access section is defined in the script, the part of the script loading
the “normal” data must be put in a different section, initiated by the statement section application. For more
information, see the QlikView online help.

Access levels
Access to QlikView documents can be authorized to specified users or groups of users. In the security table, users
are assigned the access levels Admin or User. If no access level is assigned, the user cannot open the QlikView
document.

A person with Admin access can change everything in the document. Using the Security tab in the Document
Properties and Sheet Properties dialogs, a person with Admin access can limit the users’ possibilities of
modifying the document. A person with User privileges cannot access those tabs.

Example:

Section Access; LOAD * INLINE [ACCESS,USERID,PASSWORD ADMIN,A,X USER,U,Y ]; Section Application; LOAD ...
FROM ...
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Security fields
The access levels are assigned to users in one or several tables loaded within the section access. These tables can
contain several special security fields, typically USERID and PASSWORD or NTNAME, and the field defining the
access level, ACCESS. For more information, see the QlikView online help.

Other fields such as GROUP or ORGANIZATION may be added to facilitate the administration, but QlikView
does not treat these fields in any special way.

None, all, or any combination of the security fields may be loaded in the access section. If the ACCESS field is not
loaded, the section access will really not be meaningful.

ACCESS A field defining what access the corresponding user should have.

USERID A field containing an accepted User ID. QlikView will prompt for a User ID and compare it to
the value in this field. This User ID is not the same as the Windows user ID.

PASSWORD A field containing an accepted password. QlikView will prompt for a Password and compare
it to the value in this field. This password is not the same as the Windows password.

SERIAL A field containing a number corresponding to the QlikView license number (serial number).
Example: 4900 2394 7113 7304. QlikView will check the license number of the user and compare
it to the value in this field.

NTNAME A field containing a string corresponding to a Windows NT Domain user name or group name.
QlikView will fetch the logon information from the operating system and compare it to the
value in this field.

QlikView will first compare the QlikView license number (serial number) with the field SERIAL. After this it will ask
the operating system who is logged on. It will then, if necessary, prompt for User ID and Password and
compare these with the fields USERID and PASSWORD.

If the combination of Windows User ID, QlikViewUser ID, QlikViewPassword and license number is
found in the Security table, the document is opened with the corresponding access level. If not,
QlikView will deny the user access to the document. If the User ID and/or the password are not
entered correctly within three attempts the entire log-on procedure must be repeated.

Example 1: Only the license number is checked. One specific computer gets Admin access. Everyone else gets
User access.

A star can be used to mark “any license number”.

[
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Example 2: The administrator and the computer with license number “4900 2394 7113 7304” (the server on
which QlikView runs as a batch job) gets Admin access. Everyone else gets User access when entering USER as
User ID and Password.

If you have once opened a document with access restrictions by entering the correct user name and password,
the document will open again using the same credentials without prompting for them as long as the QlikView
session lasts.

Before you start this exercise, you should take a backup of the file you intend to use. The smallest
mistake in the security table could make it impossible to open the file again.

Loading security tables
Suppose you have two tables containing security information. The first table named AccessList.csv contains
the security fields USERID, PASSWORD and ACCESS. The second table named AccessSerial.csv the security
field SERIAL. Since the same associative logic that is the hallmark of QlikView is used also in the access section,
the tables will be associated using the optional field COMPUTER NAME.

All fields listed in load or select statements in the section access must be written in upper case. Any
field name containing lower case letters in the database will be converted to upper case when being
read by the load or select statement. The user ID and the password entered by the end user
opening the QlikView document are case insensitive.

USERID PASSWORD ACCESS GROUP COMPUTER NAME

Sharon 7VFI1R ADMIN IT All

Sharon FROMME2U USER IT All

Bob LOVE15 ADMIN Marketing Bob

Bob 15ALL USER Marketing All

Pete NUMBER1 USER Personnel All

Sarah ABSOLUT USER Personnel Sarah

COMPUTER NAME SERIAL

Sharon 1234 5678 9012 3456
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Bob 1234 5678 9012 3457

Pete 1234 5678 9012 3458

Sarah 1234 5678 9012 3459

All *

The license number must be given in 4x4 number groups separated by a blank.

To load the table above. Do the following:

1. Open the document for which you want access control, for example, Advanced.qvw.

2. Save the file as Advanced.qvw in the same folder.

3. Open the Edit Script dialog and position the cursor at the beginning of the script, but after the set
statements.

4. For the tables to be used for access control, the statements loading them need to be placed in a separate
section. Type section access; and press Return to get to a new line.

Do not forget the semicolon, it indicates the end of a statement.

5. Click Table Files.

6. Select the files AccessList.csv and AccessSerial.csv (in the ..\Tutorials source\Advanced\Data Sources
directory) and click Open.

7. The files are opened in the file wizard. Make sure the labels are recognized properly, then click Finish for
both files.

8. To distinguish the access section from the application section, position the cursor after the statements
loading the security tables, then type section application;. Again, do not forget the semicolon.
The first part of your script has the following appearance:

Section access; Directory; LOAD USERID, PASSWORD, ACCESS, GROUP, [COMPUTER NAME] FROM [Data
Sources\AccessList.csv] (txt, codepage is 1252, embedded labels, delimiter is ',', msq); LOAD [COMPUTER
NAME], SERIAL FROM [Data Sources\AccessSerial.csv] (txt, codepage is 1252, embedded labels, delimiter is
',', msq); Section application; Directory; Country: LOAD Country, Capital,...

9. Choose Reload to execute the script.

10. Click OK to close the dialog.

The following access rights will be granted
Sharon - will have access rights from all the computers (since all the license numbers are allowed). Depending
on which password she uses she will be granted either Admin or User access rights.

Bob - will have Admin rights when he sits at his own computer (license number “1234 5678 9012 3457”) and
enters his UserID (Bob) and Password (LOVE15). He will have User rights on all the computers (all license
numbers allowed) when he gives his UserID (Bob) and Password (15ALL).

Pete - will have User access from all the computers provided he gives his UserID and correct Password.
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Sarah - will have to use her own computer (License number “1234 5678 9012 3459”) and give a correct UserID
and Password to be able to open the QlikView document with User access rights.

Using the Security tabs
People with Admin privileges can prevent the execution of certain commands. Do the following:

1. Choose Document Properties from the Settings menu.

2. Go to the Security tab.
The Security tab contains a list of QlikView commands. By deselecting a check box, that command
cannot be executed any more.

3. Deselect Add Sheets and Edit Script, then click OK.
Check that the commands you deselected are now dimmed, that is unavailable.

The deselected commands are unavailable even for users with Admin access, but these can - unlike users
with User access - reactivate them any time. If the deselected commands should be available for Admin
users any time, you can check the option Admin Override Security.

4. Save the file, then close it and exit QlikView.

There is also a Security tab in the Sheet Properties dialog, containing security settings on sheet level.
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Opening a document with access restriction
Suppose you are Pete and wish to work with the document Access.qvw. Do the following:

1. Open QlikView, then choose Open from the File menu.

2. Find the file Access.qvw and click Open.

3. QlikView prompts for the correct User ID. Type Pete, then click OK.

4. QlikView now prompts for the correct password. As Pete, you have User rights from all the computers.
Enter your password, that is NUMBER1 (case insensitive). Click OK.

If you have done everything correctly, the document now opens and you can work with it.

You cannot add sheets or view the script, since these commands have been inactivated, and
you cannot access the Security tabs (these tabs are only available for Admin users). If you
wish to be granted access to all the parts of the document, you need to type Sharon’s UserID
and Password (make sure to pick the password granting her Admin access rights).

5. Close the file.

Apart from the security settings mentioned above, QlikView supports a feature by which some of the data in a
document can be hidden from the user based on the section access log in. For more information, see the
QlikView online help.

4.9 What's next?
You have now finished the second part of the tutorial. In addition to the basic knowledge about selections, sheets
and sheet objects acquired in the first part (Working with QlikView), you have learned how different kinds of files
are loaded into the associative QlikView database and how the logical structure is created.

Furthermore we recommend the training course QlikView Developer I. There you can learn more about the load
script, data modeling, database connectivity and typical pitfalls to avoid. The course QlikView Developer II - for
advanced developers - covers complex scripting functionality as well as data cleaning, data model optimization
and performance tuning.

The final part of this tutorial, Advanced Features, lets you further explore the possibilities of QlikView. The lessons
in the final part are especially suitable for application developers, because they deepen the knowledge about
loading data and building the data structure. It differs from the first two parts in that it contains independent
lessons (the procedures performed are not based on the work done in previous lessons), thereby allowing you to
immediately go to the lesson that interests you the most.
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